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Preface

The Unified Messaging Guide for Cisco Unity Connection contains information and instructions for
configuring Cisco Unity Connection unified messaging features, and for the single-inbox feature, how
to move Exchange mailboxes between servers and how to restore Exchange mailboxes.

See the following sections:

e Documentation Conventions, page vii

e Cisco Unity Connection Documentation, page viii

¢ Obtaining Documentation and Submitting a Service Request, page viii

e Cisco Product Security Overview, page viii

Documentation Conventions

Table 1

Conventions in the Unified Messaging Guide for Unified Messaging Guide for
Cisco Unity Connection

Convention

Description

boldfaced text

Boldfaced text is used for:
e Key and button names. (Example: Select OK.)

¢ Information that you enter. (Example: Enter Administrator in the Username
box.)

<>

(angle brackets)

Angle brackets are used around parameters for which you supply a value.
(Example: In your browser, go to https://<Cisco Unity Connection server IP
address>/cuadmin.)

(hyphen)

Hyphens separate keys that must be pressed simultaneously. (Example: Press
Ctrl-Alt-Delete.)

>

(right angle
bracket)

A right angle bracket is used to separate selections that you make in the
navigation bar of Cisco Unity Connection Administration. (Example: In
Cisco Unity Connection Administration, expand Contacts > System Contacts.)

Unified Messaging Guide for Cisco Unity Connection Release 8.x g
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The Unified Messaging Guide for Cisco Unity Connection also uses the following conventions:

~

Note  Means reader take note. Notes contain helpful suggestions or references to material not covered in the
document.

A

Caution = Means reader be careful. In this situation, you might do something that could result in equipment damage
or loss of data.

Cisco Unity Connection Documentation

For descriptions and URLs of Cisco Unity Connection documentation on Cisco.com, see the
Documentation Guide for Cisco Unity Connection. The document is shipped with Connection and is
available at http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/roadmap/8xcucdg.html.

Documentation References to Cisco Unified Communications
Manager Business Edition

The name of the product known as Cisco Unified Communications Manager Business Edition in
versions 8.0 and earlier has been changed to Cisco Unified Communications Manager Business Edition
5000 in versions 8.5 and later.

In the Cisco Unity Connection 8.x documentation set, references to “Cisco Unified Communications
Manager Business Edition” and “Cisco Unified CMBE” apply to both Business Edition version 8.0 and
to Business Edition 5000 versions 8.5 and later. The references do not apply to Business Edition 6000.

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS Version 2.0.

Cisco Product Security Overview

This product contains cryptographic features and is subject to United States and local country laws
governing import, export, transfer and use. Delivery of Cisco cryptographic products does not imply
third-party authority to import, export, distribute or use encryption. Importers, exporters, distributors

Unified Messaging Guide for Cisco Unity Connection Release 8.x
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and users are responsible for compliance with U.S. and local country laws. By using this product you
agree to comply with applicable laws and regulations. If you are unable to comply with U.S. and local
laws, return this product immediately.

Further information regarding U.S. export regulations can be found at
http://www.access.gpo.gov/bis/ear/ear_data.html.

Unified Messaging Guide for Cisco Unity Connection Release 8.x
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CHAPTER 1

Introduction to Unified Messaging in Cisco Unity
Connection 8.5 and Later

In Cisco Unity Connection version 8.5, we gathered several existing features under a new feature named
Unified Messaging. These features include:

e Synchronization of voice messages in Unity Connection and Exchange mailboxes (also known as
single inbox—this feature is new in Unity Connection 8.5)

e Text-to-speech (TTS) access to Exchange email

e Access to Exchange calendars, which allows users to do meeting-related tasks by phone (for
example, hear a list of upcoming meetings, or accept or decline meeting invitations)

e Access to Exchange contacts, which allows users to import Exchange contacts and use the contact
information in personal call transfer rules and when placing outgoing calls by using voice
commands

¢ Notification of upcoming Cisco Unified MeetingPlace meetings on the phone
¢ Scheduling and joining of MeetingPlace meetings
e Transcription of Unity Connection voice messages (SpeechView)

This guide explains how to configure unified messaging features and, for single inbox, how to move
Exchange mailboxes between servers and how to restore Exchange mailboxes.

For information about SpeechView, see the “Configuring Transcription (SpeechView) in Cisco Unity
Connection 8.x” chapter of the System Administration Guide for Cisco Unity Connection Release 8.x, at

http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.htm
L.

In Cisco Unity Connection version 8.6(2), we gathered several existing features and a new feature under
the rubric of unified messaging. These features include:

e Synchronization of voice messages in Unity Connection and Office 365 mailboxes (also known as
single inbox)
e Text-to-speech (TTS) access to Office 365 email

e Access to Office 365 calendars, which allows users to do meeting-related tasks by phone (for
example, hear a list of upcoming meetings, or accept or decline meeting invitations)

e Access to Office 365 contacts, which allows users to import Office 365 contacts and use the contact
information in personal call transfer rules and when placing outgoing calls by using voice
commands

Unified Messaging Guide for Cisco Unity Connection Release 8.x
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CHAPTER

Configuring Cisco Unity Connection 8.5 and Later
and Microsoft Exchange for Unified Messaging

See the following sections:

About Unified Messaging with Exchange in Cisco Unity Connection 8.5 and Later, page 2-2

Task List for Configuring Cisco Unity Connection 8.5 and Later and Exchange for Unified
Messaging, page 2-11

Task List for Configuring Existing Cisco Unity Connection 8.5 and Later Users for Unified
Messaging, page 2-16

Confirming that Cisco Unity Connection 8.5 and Later is Licensed for Single Inbox (Cisco
Unified CMBE Only), page 2-17

Determining which Exchange Servers You Want Cisco Unity Connection 8.5 and Later to
Communicate with, page 2-17

Confirming Exchange Authentication and SSL Settings, page 2-20

Creating the Unified Messaging Services Account in Active Directory and Granting Permissions,
page 2-28

Configuring EWS Limits for the Unified Messaging Services Account (Exchange 2013 and later),
page 2-33

Configuring EWS Limits for the Unified Messaging Users (Exchange 2010 SP2 RU4 and Later),
page 2-34

Configuring EWS Limits for the Unified Messaging Services Account for Cisco Unity Connection
(Exchange 2010 SP2 RU3 and Earlier Releases), page 2-36

Enabling the WebDav Service on Exchange 2003 Servers for Cisco Unity Connection 8.5 and Later,
page 2-38

Creating a Unified Messaging Service to Access Exchange from Cisco Unity Connection 8.5 and
Later, page 2-38

Uploading CA Public Certificates for Exchange and Active Directory Servers, page 2-41
Testing Unified Messaging Services, page 2-43

Creating Unified Messaging Accounts to Link Cisco Unity Connection 8.5 and Later Users to
Exchange Mailboxes, page 2-43

Testing Unified Messaging Accounts, page 2-45

Viewing a Summary of the Configuration of Unified Messaging Accounts, page 2-46
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I About Unified Messaging with Exchange in Cisco Unity Connection 8.5 and Later

e Testing System Configuration, Including Unified Messaging, with Exchange and Cisco Unity
Connection 8.5 and Later, page 2-47

e Testing Access to Exchange Calendars, page 2-47
e Resolving SMTP Domain Name Configuration Issues, page 2-48

About Unified Messaging with Exchange in Cisco Unity
Connection 8.5 and Later

See the following sections:
e Accessing Exchange Email by Using Text to Speech, page 2-2
e Accessing Exchange Calendars and Contacts, page 2-2

e Synchronizing Voice Messages in Unity Connection and Exchange Mailboxes (Single Inbox),
page 2-3

~

Note  Microsoft Outlook 2013 is not supported with Exchange 2003.

Accessing Exchange Email by Using Text to Speech

When Cisco Unity Connection is configured to allow access to Exchange email by using text to speech,
users have the option to hear their emails read to them when they sign in to Cisco Unity Connection by
phone.

Unity Connection uses the IMAP protocol to access emails in Exchange so that the messages can be
played by using text to speech. By default, Exchange is not configured to allow IMAP access to
messages. You must enable IMAP access on each Exchange server that contains emails that you want
licensed Connection users to be able to access.

For information on enabling IMAP access to Exchange in Cisco Unity Connection 8.0, see the "Enabling
IMAP Access to Exchange in Cisco Unity Connection 8.0” section of the “Configuring Text-to-Speech
Access to Exchange Emails in Cisco Unity Connection 8.0" chapter of the System Administration Guide
for Cisco Unity Connection, available at
http://www.cisco.com/en/US/partner/docs/voice_ip_comm/connection/8x/administration/guide/8xcucs
agx.html.

Accessing Exchange Calendars and Contacts

When Cisco Unity Connection is configured to access Exchange calendars and contacts, Unity
Connection users can do the following by phone:

e Hear a list of upcoming meetings (Outlook meetings only).
e Hear a list of the participants for a meeting.

¢ Send a message to the meeting organizer.

¢ Send a message to the meeting participants.

e Accept or decline meeting invitations (Outlook meetings only).

Unified Messaging Guide for Cisco Unity Connection Release 8.x
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About Unified Messaging with Exchange in Cisco Unity Connection 8.5 and Later

e Cancel a meeting (meeting organizers only).

In addition, Unity Connection enables users to import Exchange contacts by using the Unity Connection
Messaging Assistant web tool. The contact information can then be used in rules that users create in the
Cisco Unity Connection Personal Call Transfer Rules web tool and when users place outgoing calls by
using voice commands.

If you configure a Unity Connection user for access to the Exchange calendar, you cannot also configure
the user for access to Cisco Unified MeetingPlace.

Synchronizing Voice Messages in Unity Connection and Exchange Mailboxes
(Single Inbox)

This section describes how synchronizing voice messages in Unity Connection and Exchange mailboxes
works. See the following sections:

e Where Voice Messages are Stored When Single Inbox is Configured, page 2-3

e How Single Inbox Works with ViewMail for Outlook, page 2-4

e How Single Inbox Works without ViewMail for Outlook or with Other Email Clients, page 2-4
e Accessing Secure Voice Messages in the Exchange Mailbox, page 2-5

e How transcription of Voice Messages is synchronized between Cisco Unity Connection 8.6(2) and
later with Exchange Mailboxes, page 2-5

¢ How Synchronization Works with Outlook Folders, page 2-8

¢ How Message Routing Works through SMTP Domain Name, page 2-8

e Where Deleted Messages Go, page 2-9

e Types of Unity Connection Messages that are Not Synchronized with Exchange, page 2-9
e Replication of Status Changes, page 2-10

e How Disabling and Re-enabling Single Inbox Affects the Synchronization of Unity Connection and
Exchange Mailboxes, page 2-10

e How Read/Heard Receipts, Delivery Receipts, and Non-delivery Receipts are Synchronized,
page 2-11

You may experience delay (in order of hours) in synchronization of voice messages from Exchange
server to Connection while Resynchronize All Single-Inbox Messages SysAgent task is running. It is
recommended to run Resynchronize All Single-Inbox Messages SysAgent task during off hours.

Where Voice Messages are Stored When Single Inbox is Configured

Note

All Unity Connection voice messages, including those sent from Cisco Unity Connection ViewMail for
Microsoft Outlook, are first stored in Unity Connection and are immediately replicated to the Exchange
mailbox for the recipient.

When Connection is configured for Single Inbox to Exchange, where a Blackberry Enterprise Server is
also integrated with the Exchange server to send voice mail out to Blackberry devices, there will be a
10-15 min delay between the time the voice mail hits Exchange and the notification is picked up by the
BES.To resolve the above issue you need to consider the following-

e For the Blackberry Enterprise Server - Install BES version 5.0.03 MRS5 or later.

Unified Messaging Guide for Cisco Unity Connection Release 8.x



Chapter2  Configuring Cisco Unity Connection 8.5 and Later and Microsoft Exchange for Unified Messaging |

I About Unified Messaging with Exchange in Cisco Unity Connection 8.5 and Later

For Cisco Unity Connection with Exchange 2007 or Exchange 2010, no Engineering Special is
required. For Unity Connection8.5(x), or 8.6(1) with Exchange 2003, install an Engineering Special.
You must contact the Cisco Support Group to recieve the latest Engineering Special.

How Single Inbox Works with ViewMail for Outlook

If you want users to use Outlook to send new Unity Connection voice messages, or to reply to or forward
voice messages, and if you want the messages to be synchronized with Unity Connection:

If you have not already done so, in Unity Connection Administration, add SMTP proxy addresses

for the Unity Connection users that are configured for single inbox. The SMTP proxy address for a
user must match the Exchange email address that is specified in the unified messaging account in

which single inbox is enabled.

Install ViewMail for Outlook on user workstations. Without ViewMail for Outlook installed, voice
messages are sent by Outlook as emails with .wav file attachments, and are treated as emails by
Unity Connection.

On each user workstation, associate an email account with a Unity Connection server.

Voice messages appear in the Outlook Inbox folder of the user, alongside other messages that are stored
in Exchange; the voice messages also appear in the Unity Connection mailbox of the user.

When single inbox is configured, Unity Connection adds a Voice Outbox folder to the Outlook mailbox.
Unity Connection voice messages sent from Outlook do not appear in the Sent Items folder.

Private messages cannot be forwarded.

How Single Inbox Works without ViewMail for Qutlook or with Other Email Clients

Note

If you use another email client to access Unity Connection voice messages in Exchange, or if you do not
install ViewMail for Outlook:

The email client treats Unity Connection voice messages like emails with .wav file attachments.

When a user replies to or forwards a Unity Connection voice message, the reply or forward also is
treated like an email, even if the user attaches a .wav file. Message routing is handled by Exchange,
not by Unity Connection, so the message is never sent to the Unity Connection mailbox for the
recipient.

Users cannot listen to secure voice messages.

It may be possible to forward private voice messages. (When users use ViewMail for Outlook,
ViewMail for Outlook prevents private messages from being forwarded.)

If a voice message is sent to the user of Exchange 2003, it is immediately synchronized between Unity
Connection and Exchange. The .wav file attachment is displayed both in Unity Connection Web Inbox
and Outlook of Exchange 2003. In Outlook WebMail Access of Exchange 2003, the email shows the
attachment symbol but when the email is opened, the .wav file attachment is not displayed. Both in
Outlook and OWA of Exchange 2007, 2010 and 2013 (Unity Connection 8.6(2) SU3 and later), the .wav
file attachment is displayed in the email.

[ Unified Messaging Guide for Cisco Unity Connection Release 8.x
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Configuring Cisco Unity Connection 8.5 and Later and Microsoft Exchange for Unified Messaging

About Unified Messaging with Exchange in Cisco Unity Connection 8.5 and Later

Accessing Secure Voice Messages in the Exchange Mailbox

To play secure Unity Connection voice messages in the Exchange mailbox, users must use Microsoft
Outlook and Cisco Unity Connection ViewMail for Microsoft Outlook. Without ViewMail for Outlook
installed, users accessing secure voice messages see only text in the body of a decoy message; the text
briefly explains secure messages.

How transcription of Voice Messages is synchronized between Cisco Unity Connection 8.6(2) and
later with Exchange Mailboxes

In Cisco Unity Connection 8.6(1) and earlier releases, the transcriptions were only available at Unity
Connection server and read using either IMAP client or Web Inbox. With Cisco Unity Connection 8.6(2)
and later releases, the system administrator can enable the SpeechView transcriptions synchronization
to single inbox. To enable transcription of voice messages, Unity Connection users must configure the
following services:

e Unified Messaging Service: To configure the Unified Messaging Service, see the "Creating a
Unified Messaging Service to Access Exchange from Cisco Unity Connection 8.5 and later" section
of "Configuring Cisco Unity Connection 8.5 and Later and Microsoft Exchange for Unified
Messaging" chapter in Unified Messaging Guide for Cisco Unity Connection.
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/unified_messaging/guide/85xcu
cumgx.html

e SpeechView Transcription Service: To configure the Speech View Transcription Service, see the
"Overview of SpeechView in Cisco Unity Connection 8.x" section of "Configuring Transcription
(SpeechView) in Cisco Unity Connection 8.x" chapter in the System Administration Guide for
Cisco Unity Connection guide.

http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagp
df.pdf

Note that the following services are not supported with Unity Connection 8.6(2), if configured with
single inbox:

— Synchronization of Multiple Forward Message
— Synchronization of transcription for user's with Exchange 2003

In single inbox, the transcription of Voice Messages is synchronized with Exchange in the following
ways:

¢ When sender sends voice mail to Unity Connection user through Web Inbox or touchtone
conversation user interface and the Unity Connection user views voice mail through various email
clients, then the transcription of voice messages are synchronized, as shown in the Table 2-1.

Table 2-1 When Sender Sends Voice Mail Through Web Inbox or
Touchtone Conversation User Interface

Unified Messaging Guide for Cisco Unity Connection Release 8.x
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Scenarios

Web Inbox

Outlook WebMail
Access/ Outlook
without VMO

ViewMail for Outlook

Successful delivery of
voice messages

The text of the
transcription gets
displayed in the reading
pane of the email.

The text of transcription
gets displayed in the
reading pane of the
email.

The text of the
transcription gets
displayed in the reading
pane of the email and is
also displayed in the
transcription panel.

Failure or Response
Time-out

The “Failure or
Response Timeout” text
gets displayed in the
reading pane of the
email.

The “Failure or
Response Timeout” text
gets displayed in the
reading pane of the
email.

The “Failure or
Response Timeout” text
gets displayed in the
reading pane of the
email and is also
displayed in the
transcription panel.

Transcription in
Progress

The “Transcription in
Progress” text gets
displayed in the reading
pane of the email.

The reading pane of the
email will be blank.
text.

The “Transcription in
Progress” text gets
displayed in the
transcription panel.

e When sender sends voice mail to Unity Connection user through ViewMail for Outlook and the
Unity Connection user views voice mail through various email clients, then the transcription of
voice messages are synchronized, as shown in the Table 2-2:

Table 2-2 When Sender Sends Voice Maill Through ViewMail for Outlook
Outlook WebMail
Access/ Outlook
Scenarios Web Inbox without VMO ViewMail for Outlook

Successful delivery of
voice messages

The Text of
transcription gets
displayed in the reading
pane of the email.

The text of the
transcription is the part
of transcript file
“Transcription.txt”.

The text of the
transcription is the part
of transcript file
“Transcription.txt” and
is also displayed in the
transcription panel.
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Outlook WebMail
Access/ Outlook
Scenarios Web Inbox without VMO ViewMail for Outlook
Failure or Response The “Failure or The “Failure or The “Failure or
Time-out Response Timeout” text |Response Time-out” Response Time-out”
gets displayed in the text is the part of text is the part of
reading pane of the transcript file transcript file
email. “Trancription.txt” “Trancription.txt”
attached in the voice attached in the voice
message. message and is also
displayed in the
transcription panel
Transcription in The “Transcription in | The attachment The attachment
Progress Progress” text gets “Transcription_pending |“Transcription_pending
displayed in the reading |.txt” indicates the .txt” indicates the
pane of the email. progress of progress of
transcription. transcription and the
text “Transcription in
Progress” is also
displayed in
transcription panel.

~

Note  Voice messages received by Unity Connection, which are composed using ViewMail for
Outlook have message body either with text or blank body.

e Synchronizing the transcription of voice messages, when the sender sends voice mail to Unity
Connection through third-party email clients and the receiver views the voice mail through various
clients.

— The transcription of voice messages can be synchronized in either of the above mentioned
scenarios.

When a sender sends a voice message to a Unity Connection user, Cisco Unity Connection sends the
received voice message to the Nuance server for the transcription of voice messages. However, in case
of any failure/error in the transcription of voice messages, Nuance server sends back the error code to
Cisco Unity Connection. For more information on Nuance server error codes, see “Managing Nuance
Server Code in Cisco Unity Connection 8.6(2) and later” chapter of the System Administration Guide for
Cisco Unity Connection:
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.htm
L.

Transcription of Voice messages in Secure and Private Messages

Revised February 08, 2014
e Secure Messages: Secure messages are transcribed only if the user belongs to a class of service for
which the Allow Transcriptions of Secure Messages option is enabled. This option, however, does
not allow the synchronization of transcribed secure messages on the Exchange server integrated with
the Unity Connection server.

e Private Messages: The transcription of private messages is not supported.
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How Synchronization Works with Qutlook Folders

Unity Connection synchronizes voice messages in the following Outlook folders with the Unity
Connection Inbox folder for the user, so the messages are still visible in the Unity Connection Inbox
folder:

¢ Subfolders under the Outlook Inbox folder
e Subfolders under the Outlook Deleted Items folder
e The Outlook Junk Email folder
Messages in the Outlook Deleted Items folder appear in the Unity Connection deleted items folder.

If the user moves voice messages (except secure voice messages) into Outlook folders that are not under
the Inbox folder, the messages are moved to the deleted items folder in Unity Connection. The messages
can still be played by using ViewMail for Outlook because a copy still exists in the Outlook folder. If
the user moves the messages back into the Outlook Inbox folder or into an Outlook folder that is
synchronized with the Unity Connection Inbox folder, and:

e If the message is still in the deleted items folder in Unity Connection, the message is synchronized
back into the Unity Connection Inbox for that user.

e If the message is not still in the deleted items folder in Unity Connection, the message is still
playable in Outlook, but it is not resynchronized into Unity Connection.

Secure voice messages behave differently. When Unity Connection replicates a secure voice message to
Exchange, it replicates only a decoy message that briefly explains secure messages; the only copy of the
voice message remains on the Unity Connection server. When a user plays a secure message by using

ViewMail for Outlook, ViewMail retrieves the message from the Unity Connection server and plays it
without ever storing the message in Exchange or on the computer of the user.

If the user moves a secure message to an Outlook folder that is not synchronized with the Unity
Connection Inbox folder, the only copy of the voice message is moved to the deleted items folder in
Unity Connection, and the message can no longer be played in Outlook. If the user moves the message
back into the Outlook Inbox folder or into an Outlook folder that is synchronized with the Unity
Connection Inbox folder, and:

e If the message is still in the deleted items folder in Unity Connection, the message is synchronized
back into the Unity Connection Inbox for that user, and the message becomes playable again in
Outlook.

e If the message is not still in the deleted items folder in Unity Connection, the message is not
resynchronized into Unity Connection and can no longer be played in Outlook.

How Message Routing Works through SMTP Domain Name

Cisco Unity Connection uses SMTP domain name to route messages between digitally networked
Connection servers and to construct the SMTP address of the sender on outgoing SMTP messages. For
each user, Unity Connection creates an SMTP address of <Alias>@<SMTP Domain>. This SMTP
address is displayed on the Edit User Basics page for the user. Examples of outgoing SMTP messages
that use this address format include messages sent by users on this server to recipients on other digitally
networked Unity Connection servers and messages that are sent from the Unity Connection phone
interface or Messaging Inbox and relayed to an external server based on the Message Actions setting of
the recipient.

Unity Connection also uses the SMTP Domain to create sender VPIM addresses on outgoing VPIM
messages, and to construct the From address for notifications that are sent to SMTP notification devices.
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Note

About Unified Messaging with Exchange in Cisco Unity Connection 8.5 and Later

When Unity Connection is first installed, the SMTP Domain is automatically set to the fully qualified
host name of the server.

Make sure that the SMTP domain of Cisco Unity Connection is different from the Corporate Email
domain to avoid issues in message routing for Cisco Unity Connection.

Some scenarios in which you may encounter issues with the same domain are listed below:
¢ Routing of the voice messages between digitally networked Unity Connection servers
e Relaying of the messages
¢ Replying and Forwarding of the voice messages using ViewMail for Outlook
¢ Routing of the SpeechView messages to Cisco Unity Connection server
¢ Sending the SMTP message Notifications
e Routing of the VPIM messages

Cisco Unity Connection requires a unique SMTP domain for every user, which is different from the
corporate email domain. Due to same domain name configuration on Microsoft Exchange and

Cisco Unity Connection, the users who are configured for Unified Messaging may face issues in adding
recipient while composing, replying and forwarding of messages.For more information on resolving
domain name configuration issues, see the Creating Unified Messaging Accounts, page 2-44 section.

Where Deleted Messages Go

By default, when a user deletes a voice message in Unity Connection, the message is sent to the Unity
Connection deleted items folder and synchronized with the Outlook Deleted Items folder. When the
message is deleted from the Unity Connection deleted items folder (the user can do this manually, or you
can configure message aging to do it automatically), it is also deleted from the Outlook Deleted Items
folder.

If you are adding the single-inbox feature to an existing system, and if you have configured Unity
Connection to permanently delete messages without saving them in the deleted items folder, messages
that users delete by using the Web Inbox or by using the Unity Connection phone interface are still
permanently deleted. However, messages that users delete by using Outlook are only moved to the
Deleted Items folder in Outlook, not permanently deleted. When Unity Connection synchronizes with
Exchange, the message is moved to the Unity Connection deleted items folder; it is not permanently
deleted. We recommend that you do one or both of the following:

¢ Configure message aging to permanently delete messages in the Unity Connection deleted items
folder.

¢ Configure message quotas, so that Unity Connection prompts users to delete messages when their
mailboxes approach a specified size.

When a user deletes a voice message from any Outlook folder, including the Outlook Inbox folder, the
Deleted Items folder, or any subfolder, the message is moved to the deleted items folder in Unity
Connection. No operation in Outlook will cause a message to be permanently deleted in Unity
Connection.

Types of Unity Connection Messages that are Not Synchronized with Exchange

The following types of messages are not synchronized:

e Sent messages
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Draft messages
Messages configured for future delivery but not yet delivered
Broadcast messages

Unaccepted dispatch messages. When a dispatch message has been accepted by a recipient, it
becomes a normal message and is synchronized with Exchange for the user who accepted it and
deleted for all other recipients. Until someone on the distribution list accepts a dispatch message,
the message waiting indicator for everyone on the distribution list will remain on, even when users
have no other unread messages.

Replication of Status Changes

Status changes (for example, from unread to read), changes to the subject line, and changes to the
priority are replicated from Unity Connection to Exchange and vice versa, as applicable.

How Disabling and Re-enabling Single Inbox Affects the Synchronization of Unity Connection and
Exchange Mailboxes

When you configure unified messaging, you create one or more unified messaging services that define,
among other things, which unified messaging features are enabled. You also create one or more unified
messaging accounts for each user to associate the user with unified messaging services. You can disable
single inbox in three ways:

Entirely disable a unified messaging service in which single inbox is enabled. This disables all
enabled unified messaging features (including single inbox) for all users that are associated with the
service.

Disable only the single inbox feature for a unified messaging service, which disables only the single
inbox feature for all users that are associated with that service.

Disable single inbox for a unified messaging account, which disables single inbox only for the
associated user.

If you disable and later re-enable single inbox by using any of these methods, Connection resynchronizes
the Connection and Exchange mailboxes for the affected users. Note the following:

If users delete messages in Exchange but do not delete the corresponding messages in Connection
while single inbox is disabled, the messages will be resynchronized into the Exchange mailbox
when single inbox is re-enabled.

If messages are hard deleted from Exchange (deleted from the Deleted Items folder) before single
inbox is disabled, the corresponding messages that are still in the deleted items folder in Unity
Connection when single inbox is re-enabled will be resynchronized into the Exchange Deleted Items
folder.

If users delete messages in Connection but do not delete the corresponding messages in Exchange
while single inbox is disabled, the messages remain in Exchange when single inbox is re-enabled.
Users must delete the messages from Exchange manually.

If users change the status of messages in Exchange (for example, from unread to read) while single
inbox is disabled, the status of Exchange messages will be changed to the current status of the
corresponding Unity Connection messages when single inbox is re-enabled.

When you re-enable single inbox, depending on the number of users associated with the service and
the size of their Connection and Exchange mailboxes, resynchronization for existing messages may
affect synchronization performance for new messages.
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How Read/Heard Receipts, Delivery Receipts, and Non-delivery Receipts are Synchronized

Unity Connection can send heard/read receipts, delivery receipts, and non-delivery receipts to Unity
Connection users who send voice messages. If the sender of a voice message is configured for single
inbox, the applicable receipt is sent to the Unity Connection mailbox for the sender. The receipt is then
synchronized into the Exchange mailbox for the sender.

Note the following.

Read/heard receipts: When sending a voice message, a sender can request a read/heard receipt. If
you do not want Unity Connection to respond to requests for read receipts, in Unity

Connection Administration, uncheck the Respond to Requests for Read Receipts check box, which
appears on the Users > Edit > Mailbox page and on the Templates > User Templates > Edit >
Mailbox page.

Delivery receipts: A sender can request a delivery receipt only when sending a voice message from
ViewMail for Outlook. You cannot prevent Unity Connection from responding to a request for a
delivery receipt.

Non-delivery receipts (NDR): A sender receives an NDR when a voice message cannot be delivered.
If you do not want Unity Connection to send an NDR when a message cannot be delivered, in Unity
Connection Administration, uncheck the Send Non-Delivery Receipts for Message Failed Delivery
check box, which appears on the Users > Edit User Basics page and on the Templates > User
Templates > Edit User Template Basics page.

Note the following about NDRs:

— When the sender accesses Unity Connection by using the TUI, the NDR includes the original
voice message, which allows the sender to resend the message at a later time or to a different
recipient.

— When the sender accesses Unity Connection by using Web Inbox, the NDR includes the original
voice message, but the sender cannot resend it.

— When the sender uses ViewMail for Outlook to access Unity Connection voice messages that
have been synchronized into Exchange, the NDR is a receipt that contains only an error code,
not the original voice message, so the sender cannot resend the voice message.

— When the sender is an outside caller, NDRs are sent to Unity Connection users on the
Undeliverable Messages distribution list. Verify that the Undeliverable Messages distribution
list includes one or more users who regularly monitors and reroutes undelivered messages.

Task List for Configuring Cisco Unity Connection 8.5 and Later
and Exchange for Unified Messaging

To configure one or more unified messaging features, complete the following tasks in the order
presented.

1.

Review the “Requirements for Using Unified Messaging Features (Connection 8.5 and Later Only)”
section in the System Requirements for Cisco Unity Connection Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucsysreqs.html

Cisco Unified Communications Manager Business Edition only: Confirm that Unity Connection is
licensed for single inbox. See the “Confirming that Cisco Unity Connection 8.5 and Later is
Licensed for Single Inbox (Cisco Unified CMBE Only)” section on page 2-17.
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3. If Unity Connection is integrated with an LDAP directory: Review the current LDAP directory
configurations to confirm that the Cisco Unified Communications Manager Mail ID field is
synchronized with the LDAP mail field. During the integration process, this causes values in the
LDAP mail field to appear in the Corporate Email Address field in Unity Connection.

Unified messaging requires that you enter the Exchange email address for each Unity Connection
user. On the Unified Messaging Account page, each user can be configured to use either of the
following values:

— The Corporate Email Address specified on the User Basics page
— The email address specified on the Unified Messaging Account page

Automatically populating the Corporate Email Address field with the value of the LDAP mail field
is easier than populating the email address field on the Unified Messaging Account page by using
Unity Connection Administration or the Bulk Administration Tool.

If the Cisco Unified CM Mail ID field is synchronized with the sSAMAccountName instead of the
mail field, consider changing the LDAP directory configurations. For more information, see the
“Changing LDAP Directory Configurations in Cisco Unity Connection 8.x” section in the
“Integrating Cisco Unity Connection 8.x with an LDAP Directory” chapter in the System
Administration Guide for Cisco Unity Connection Release 8.x, available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx
.html.

4. Ifyou are using single inbox and you want users to be able to use ViewMail for Outlook to send new
voice messages, or to forward or reply to voice messages: Install Cisco Unity Connection ViewMail
for Microsoft Outlook on user workstations. For more information on installing ViewMail for
Outlook, see the Release Notes for Cisco Unity Connection ViewMail for Microsoft Outlook Release
8.5(x) at http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.

5. Decide whether you want Unity Connection to communicate with a specific Exchange 2013 (Unity
Connection8.6(2) SU3 and later), Exchange 2010 or 2007 client access server or Exchange 2003
server, or you want Unity Connection to be able to search for and communicate with different
Exchange servers as required. See the “Determining which Exchange Servers You Want Cisco Unity
Connection 8.5 and Later to Communicate with” section on page 2-17.

When you are using Exchange 2013 (Unity Connection 8.6(2) SU3 and later), Exchange 2010,
and/or Exchange 2007, Unity Connection searches for Exchange servers as described in White
Paper: Exchange 2007 Autodiscover Service, available on the Microsoft website.

~

Note  Unity Connection determines whether to use the HTTP or HTTPS protocol and whether to
validate certificates based on settings in the applicable unified messaging service.

6. If you decided in Task 5. to allow Unity Connection to search for and communicate with different
Exchange servers as required, and if Unity Connection is not already configured to use DNS, use
the following CLI commands to configure DNS:

— set network dns
— set network dns options

We recommend that you configure Unity Connection to use the same DNS environment in which the
Active Directory environment is publishing its records.

For more information on the CLI commands, see the applicable Command Line Interface Reference
Guide for Cisco Unified Communications Solutions at
http://www.cisco.com/en/US/products/ps6509/prod_maintenance_guides_list.html.

Unified Messaging Guide for Cisco Unity Connection Release 8.x
[ 212 | I


http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsag306.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.html
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html
http://www.cisco.com/en/US/products/ps6509/prod_maintenance_guides_list.html

| Chapter2 Configuring Cisco Unity Connection 8.5 and Later and Microsoft Exchange for Unified Messaging

1.

S

Note

10.

1.

12.

13.

14.

Task List for Configuring Cisco Unity Connection 8.5 and Later and Exchange for Unified Messaging I

Confirm that all of the Exchange servers that Unity Connection will access are configured to use the
desired authentication mode (basic, digest, or NTLM) and web-based protocol (HTTPS or HTTP).
See the “Confirming Exchange Authentication and SSL Settings” section on page 2-20.

If you want to configure SSL to encrypt the communication between Unity Connection and
Exchange, configure Exchange to use HTTPS for the web-based protocol.

Create an Active Directory account to be used for Unity Connection unified messaging services, and
grant the account the applicable permissions. See the “Creating the Unified Messaging Services
Account in Active Directory and Granting Permissions” section on page 2-28.

Ifyou are using Exchange 2013 and Later (Unity Connection 8.6(2) SU3 and later): Configure EWS
limits for the unified messaging services account. See the “Configuring EWS Limits for the Unified
Messaging Users (Exchange 2010 SP2 RU4 and Later)” section on page 2-34.

If you are using Exchange 2010 SP2 RU4 and Later: Configure EWS limits for the unified
messaging users. See the “Configuring EWS Limits for the Unified Messaging Users
(Exchange 2010 SP2 RU4 and Later)” section on page 2-34.

If you are using Exchange 2010 SP2 RU3 and Earlier Releases: Configure EWS limits for the
unified messaging services account. See the “Configuring EWS Limits for the Unified Messaging
Services Account for Cisco Unity Connection (Exchange 2010 SP2 RU3 and Earlier Releases)”
section on page 2-36.

If you are using Exchange 2003: Enable the WebDav service. See the “Enabling the WebDav Service
on Exchange 2003 Servers for Cisco Unity Connection 8.5 and Later” section on page 2-38.

If you are using single inbox and users do not already have added SMTP proxy addresses: Add
proxy addresses to Unity Connection user accounts. For more information, see the “SMTP Proxy
Addresses in Cisco Unity Connection 8.x” section in the “Setting Up Features and Functionality
That Are Controlled by User Account Settings in Cisco Unity Connection 8.x” chapter of the User
Moves, Adds, and Changes Guide for Cisco Unity Connection Release 8.x, available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx.htm
L.

Update class of service settings as required:

— Enable single inbox in one or more classes of service. For more information, see the “Single
Inbox in Cisco Unity Connection 8.5 and Later” section in the “Setting Up Features and
Functionality That Are Controlled by Class of Service in Cisco Unity Connection 8.x” chapter
of the User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 8.x, available
at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx
.html.

Note that all users who are configured to use single inbox must be in a class of service in which
single inbox is enabled.

Cisco Unified Communications Manager Business Edition only: Unity Connection counts all
users in a class of service in which single inbox is enabled as single inbox users even if they are
not configured to use single inbox. For example, if a Unity Connection server is licensed for
200 single-inbox users, and if you have three classes of service in which single inbox is enabled,
the total number of users assigned to those three classes of service cannot exceed 200 users. This
is true even if you only configure 50 users to use single inbox.
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— Enable text-to-speech access to Exchange voice messages on one or more classes of service:
check the Allow Access to Advanced Features check box on the applicable class of service
page, and then check the Allow Access to Exchange Email by Using Text to Speech (TTS)
check box.

15. If classes of service for single-inbox users have Delete Messages without Saving to Deleted Items
Folder enabled: We recommend that you configure message aging and/or message quotas.
Otherwise, messages deleted from Outlook may never be permanently deleted from Unity
Connection. For more information, see the “Synchronizing Voice Messages in Unity Connection and
Exchange Mailboxes (Single Inbox)” section on page 2-3.

For more information on configuring message aging and message quotas for Unity Connection, see
the “Controlling the Size of Mailboxes in Cisco Unity Connection 8.x” chapter in the System
Administration Guide for Cisco Unity Connection Release 8.x, available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx
.html.

16. Configure one or more Unity Connection unified messaging services. See the “Creating a Unified
Messaging Service to Access Exchange from Cisco Unity Connection 8.5 and Later” section on
page 2-38.

17. Selected configurations: In either or both of the following configurations, upload SSL certificates
on the Unity Connection server to encrypt communication between Unity Connection and Exchange
and between Unity Connection and Active Directory:

— Ifyou configured Exchange to use HTTPS in Task 7. and configured unified messaging services
to validate certificates for Exchange servers in Task 16.

— If you configured Unity Connection to search for and communicate with different Exchange
servers, to use LDAPS to communicate with domain controllers, and to validate certificates for
domain controllers in Task 16.

A

Caution  When you allow Unity Connection to search for and communicate with different Exchange
servers, Unity Connection communicates with Active Directory servers using Basic
authentication. By default, the user name and password of the unified messaging services
account and all other communication between the Unity Connection and Active Directory
servers is sent in clear text. If you want this data to be encrypted, in Task 16. you must
configure unified messaging services to communicate with Active Directory domain
controllers by using the secure LDAP (LDAPS) protocol.

For more information, see the “Uploading CA Public Certificates for Exchange and Active
Directory Servers” section on page 2-41.

18. Test the unified messaging services. See the “Testing Unified Messaging Services” section on
page 2-43.

19. Update Unity Connection user accounts:

— Single inbox and text to speech only: Update user settings to assign each user for whom single
inbox or text to speech is enabled to a class of service in which single inbox or text to speech is
enabled. See the applicable chapter in the User Moves, Adds, and Changes Guide for
Cisco Unity Connection Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx
.html: either “Modifying or Deleting Individual User Accounts in Cisco Unity Connection 8.x”
or “Managing Cisco Unity Connection 8.x User Accounts in Bulk.”
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Create unified messaging accounts for Unity Connection users. See the “Creating Unified
Messaging Accounts to Link Cisco Unity Connection 8.5 and Later Users to Exchange
Mailboxes” section on page 2-43.

If you configured message aging and/or message quotas in Task 15.: Configure user accounts
as applicable.

For information on changing message aging settings for individual users, see the “Message
Aging in Cisco Unity Connection 8.x” section in the “Setting Up Features and Functionality
That Are Controlled by User Account Settings in Cisco Unity Connection 8.x” chapter of the
User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx
.html.

For information on changing message quota settings for individual users, see the “Mailbox-Size
Quotas in Cisco Unity Connection 8.x section in the “Setting Up Features and Functionality
That Are Controlled by User Account Settings in Cisco Unity Connection 8.x” chapter of the
User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx
.html.

Test unified messaging accounts for Unity Connection users. See the “Testing Unified Messaging
Accounts” section on page 2-45.

Test the unified messaging configuration. See the following sections:

Viewing a Summary of the Configuration of Unified Messaging Accounts, page 2-46

Testing System Configuration, Including Unified Messaging, with Exchange and Cisco Unity
Connection 8.5 and Later, page 2-47

Testing Access to Exchange Calendars, page 2-47

If Unity Connection voice messages are automatically being moved to the Outlook Junk Items folder:
Change the Outlook configuration to add the sender of the voice message or the sender’s domain to
the safe sender’s list. For more information, see Outlook Help.

To teach users how to use the Unity Connection calendar, refer them to the following:

For listing, joining, and scheduling meetings, see the “Cisco Unity Connection Phone Menus
and Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone
Interface (Release 8.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/phone/b_8xcucu
gphone.html.

For importing Exchange contacts, see the “Managing Your Personal Contacts” chapter of the
User Guide for the Cisco Unity Connection Messaging Assistant Web Tool (Release 8.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/assistant/b_8xcu
cugasst.html.

For using personal call transfer rules, see the User Guide for the Cisco Unity Connection
Personal Call Transfer Rules Web Tool (Release 8.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/pctr/b_8xcucugp
ctr.html.
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Task List for Configuring Existing Cisco Unity Connection 8.5
and Later Users for Unified Messaging

After you configure unified messaging by following the “Task List for Configuring Cisco Unity
Connection 8.5 and Later and Exchange for Unified Messaging” section on page 2-11, do the following
tasks when you want to add unified messaging features for existing users.

1. Single inbox or TTS for Cisco Unified CMBE only: Ensure that you have sufficient licenses for the
additional users. See the “Confirming that Cisco Unity Connection 8.5 and Later is Licensed for
Single Inbox (Cisco Unified CMBE Only)” section on page 2-17.

2. Ifyou are using single inbox and you want users to be able to use ViewMail for Outlook to send new
voice messages, or to forward or reply to voice messages: Add proxy addresses to Unity Connection
user accounts. For more information, see the “SMTP Proxy Addresses in Cisco Unity Connection
8.x” section in the “Setting Up Features and Functionality That Are Controlled by User Account
Settings in Cisco Unity Connection 8.x” chapter of the User Moves, Adds, and Changes Guide for
Cisco Unity Connection Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx.htm
L.

3. Update Unity Connection user accounts:

— Single inbox and text to speech only: Update user settings to assign each user for which single
inbox or text to speech is enabled to a class of service in which single inbox or text to speech is
enabled. See the applicable chapter in the User Moves, Adds, and Changes Guide for
Cisco Unity Connection Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx
.html: either “Modifying or Deleting Individual User Accounts in Cisco Unity Connection 8.x”
or “Managing Cisco Unity Connection 8.x User Accounts in Bulk.”

— Create unified messaging accounts for Unity Connection users. See the “Creating Unified
Messaging Accounts to Link Cisco Unity Connection 8.5 and Later Users to Exchange
Mailboxes” section on page 2-43.

— If you configured message aging and/or message quotas in Task 15.: Configure user accounts
as applicable.

For information on changing message aging settings for individual users, see the “Message
Aging in Cisco Unity Connection 8.x” section in the “Setting Up Features and Functionality
That Are Controlled by User Account Settings in Cisco Unity Connection 8.x” chapter of the
User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx
html.

For information on changing message quota settings for individual users, see the “Mailbox-Size
Quotas in Cisco Unity Connection 8.x” section in the “Setting Up Features and Functionality
That Are Controlled by User Account Settings in Cisco Unity Connection 8.x” chapter of the
User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx
html.

4. Test unified messaging accounts for Unity Connection users. See the “Testing Unified Messaging
Accounts” section on page 2-45.

5. If Unity Connection voice messages are automatically being moved to the Outlook Junk Items folder:
Change the Outlook configuration to add the sender of the voice message or the domain of the sender
to the safe sender’s list. For more information, see Outlook Help.
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Confirming that Cisco Unity Connection 8.5 and Later is
Licensed for Single Inbox (Cisco Unified CMBE Only)

Step 1
Step 2

Step 3

If you want to use the Unity Connection 8.5 single inbox feature with Cisco Unified Communications
Manager Business Edition, Unity Connection must be licensed for single inbox, and you must have
enough licenses for the number of users you want to configure for single inbox.

To Confirm that Cisco Unity Connection 8.5 Is Licensed for Single Inbox (Cisco Unified CMBE Only)

In Cisco Unity Connection Administration, expand System Settings, then select Licenses.

In the Licensed Seats column, find the Users with IMAP or Single Inbox Access to Voice Messages
license setting.

In the Value column, confirm that you have enough licenses for the number of users you want to
configure for Single Inbox. If you need more licenses, see the “Managing Licenses in Cisco Unity
Connection 8.x” chapter in the System Administration Guide for Cisco Unity Connection Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.htm
I for information on obtaining and installing additional licenses.

Determining which Exchange Servers You Want Cisco Unity
Connection 8.5 and Later to Communicate with

When you add a unified messaging service, which defines the communication between Unity Connection
and Exchange, you can choose whether you want Unity Connection to communicate directly with a
specific Exchange server or you want Unity Connection to search for Exchange servers. The choice you
make determines which Exchange mailboxes Unity Connection can access:

e If you choose a specific Exchange 2003 server, Unity Connection can only access mailboxes on that
Exchange server.

e If you choose a specific Exchange 2007 client access server, Unity Connection can access all
Exchange 2007 mailboxes in the Exchange organization, but cannot access Exchange 2003,
Exchange 2010, or Exchange 2013 (Unity Connection 8.6(2) SU3 and later) mailboxes.

e If you choose a specific Exchange 2010 client access server, Unity Connection can access all
Exchange 2010 and Exchange 2007 mailboxes in the Exchange organization, but cannot access
Exchange 2013 (Unity Connection 8.6(2) SU3 and later) and Exchange 2003 mailboxes.

e If you choose a specific Exchange 2013 client access server (Unity Connection 8.6(2) SU3 and
later), Unity Connection can access all Exchange 2013, Exchange 2010 and Exchange 2007
mailboxes in the Exchange organization, but cannot access Exchange 2003 mailboxes.

e If you choose to allow Unity Connection to search for Exchange servers, then you need to select
from the following two options:

— Exchange 2007 and/or 2010: Unity Connection can access every mailbox in the Exchange
organization consisting of Exchange 2007, Exchange 2010, and Exchange 2013 (Unity
Connection 8.6(2) SU3 and later).
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— Exchange 2003, 2007 and/or 2010: Unity Connection can access every mailbox in the Exchange
organization consisting of Exchange 2003, Exchange 2007, and Exchange 2010. When the
Exchange organization includes Exchange 2003 servers, Unity Connection always
communicates directly with the Exchange back-end servers, it never communicates with
Exchange front-end servers.

Note the following:

e If you want to choose a specific Exchange server when you add a unified messaging service, you
may need to add more than one unified messaging service to allow Unity Connection to access all
of the mailboxes in the Exchange organization. Table 2-3 explains when you need to add more than

one unified messaging service.

Table 2-3 Adding Unified Messaging Services Based on Versions of Exchange

Exchange Versions on Which You Have Mailboxes That You

Want Unity Connection to Be Able to Access

Exchange |Exchange |[Exchange |Exchange

2003 2007 2010 2013 Office 365 |Create the Following Unified Messaging Services

No No No No Yes e One for Office 365 server that you want Unity Connection
to be able to access.

No No Yes Yes No e One for Exchange 2013 (Unity Connection 8.6(2) SU3
and later). This service can also access Exchange 2010
mailboxes.

No No Yes Yes Yes e One for Exchange 2013 (Unity Connection 8.6(2) SU3
and later). This service can also access Exchange 2010
mailboxes.

¢ One for Office 365 server that you want Unity Connection
to be able to access.

No Yes No No No e One for Exchange 2007.

No Yes No No Yes e One for Exchange 2007.

¢ One for Office 365 server that you want Unity Connection
to be able to access.

No Yes Yes Yes No e One for Exchange 2013 (Unity Connection 8.6(2) SU3
and later). This service can also access Exchange 2010
and 2007 mailboxes.

No Yes Yes Yes Yes ¢ One for Exchange 2013 (Unity Connection 8.6(2) SU3
and later). This service can also access Exchange 2010
and 2007 mailboxes.

e One for Office 365 server that you want Unity Connection
to be able to access.

Yes No No No No e One for each Exchange 2003 server that you want Unity
Connection to be able to access.

Yes No No No Yes e One for each Exchange 2003 server that you want Unity
Connection to be able to access.

e One for Office 365 server that you want Unity Connection
to be able to access
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Exchange Versions on Which You Have Mailboxes That You
Want Unity Connection to Be Able to Access

Exchange |Exchange Exchange |Exchange
2003 2007 2010 2013 Office 365 |Create the Following Unified Messaging Services

Yes No Yes Yes No ¢ One for each Exchange 2003 server that you want Unity
Connection to be able to access.

e One for Exchange 2013 (Unity Connection 8.6(2) SU3
and later). This service can also access Exchange 2010
mailboxes.

Yes No Yes Yes Yes e One for each Exchange 2003 server that you want Unity
Connection to be able to access.

e One for Exchange 2013 (Unity Connection 8.6(2) SU3
and later). This service can also access Exchange 2010
mailboxes.

e One for Office 365 server that you want Unity Connection
to be able to access

Yes Yes No No No e One for each Exchange 2003 server that you want Unity
Connection to be able to access.

e One for Exchange 2007.

Yes Yes No No Yes ¢ One for each Exchange 2003 server that you want Unity
Connection to be able to access.

e One for Exchange 2007.

e One for Office 365 server that you want Unity Connection
to be able to access

Yes Yes Yes Yes No ¢ One for each Exchange 2003 server that you want Unity
Connection to be able to access.

e One for Exchange 2013 (Unity Connection 8.6(2) SU3
and later). This service can also access Exchange 2010 or
Exchange 2007 mailboxes.

Yes Yes Yes Yes Yes e One for each Exchange 2003 server that you want Unity
Connection to be able to access.

¢ One for Exchange 2013 (Unity Connection 8.6(2) SU3
and later). This service can also access Exchange 2010 or
Exchange 2007 mailboxes.

e One for Office 365 server that you want Unity Connection
to be able to access.

e If you choose to allow Unity Connection to search for Exchange servers, Unity Connection can
automatically detect when you move mailboxes from one version of Exchange to another and can
automatically update Unity Connection user settings.

e If you choose a specific Exchange server, Unity Connection can sometimes detect when you move
mailboxes from one Exchange server to another, and can automatically access the Exchange mailbox
in the new location. When Unity Connection cannot detect mailbox moves, you must manually
update unified messaging services or unified messaging accounts:
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— Ifyou moved all of the Exchange mailboxes accessed by a unified messaging service: Update
the unified messaging service to access a different Exchange server.

- If you moved only some of the Exchange mailboxes accessed by a unified messaging service:
Update unified messaging account settings to use a unified messaging service that accesses
mailboxes in the new location.

Table 2-4 identifies when Unity Connection can and cannot automatically detect mailbox moves
between Exchange servers. For information on updating Unity Connection user settings when Unity
Connection cannot detect mailbox moves, see the “Configuring Cisco Unity Connection 8.5 and
Later and Microsoft Exchange for Unified Messaging” chapter.

Table 2-4 Choosing a Specific Exchange Server: When Unity Connection Can Detect Mailbox Moves Between
Exchange Servers

Unity Connection can automatically detect mailbox moves hetween the following Exchange
versions

2003 and |2003 and 2003 and 2007 and (2007 and ({2010 and (2007 and |2010 and |2013 and
If you choose a specific 2003 2007 2010 2007 2010 2010 2013 2013 2013
Exchange 2003 server No No No No No No No No No
Exchange 2007 server No No No Yes No No No No No
Exchange 2010 server No No No Yes Yes Yes No No No
Exchange 2013 server No No No Yes Yes Yes Yes Yes Yes

If Unity Connection is not configured to use DNS, you must choose a specific Exchange server. If
this does not allow you to access all of the Exchange mailboxes in the organization as described
earlier in this section, you must create more than one unified messaging service.

If you choose a specific Exchange server and that server stops functioning, Unity Connection cannot
access any Exchange mailboxes. If you choose to allow Unity Connection to search for Exchange
servers and if the Exchange server that Unity Connection is currently communicating with stops
functioning, Unity Connection searches for another Exchange server and begins accessing
mailboxes through that server.

Confirming Exchange Authentication and SSL Settings

Confirm that the Exchange servers that Unity Connection will access are configured to use the desired
authentication mode (basic, digest, or NTLM) and web-based protocol (HTTPS or HTTP). For
information on which Exchange servers Unity Connection will access, see the “Determining which
Exchange Servers You Want Cisco Unity Connection 8.5 and Later to Communicate with” section on
page 2-17.

Later in the task list, you will create one or more Unity Connection unified messaging services, and
select the same authentication mode and web-based protocol that you specify in Exchange when you do
the applicable procedures in this section.

Do the procedure in the applicable section:

Appendix 2, “Confirming Exchange 2013 Authentication and SSL Settings for Cisco Unity
Connection”

Confirming Exchange 2013 Authentication and SSL Settings for Cisco Unity Connection,
page 2-21
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e Confirming Exchange 2007 Authentication and SSL Settings, page 2-25
¢ Confirming Exchange 2003 Authentication and SSL Settings, page 2-26

Confirming Exchange 2013 Authentication and SSL Settings for Cisco Unity

Connection

Step 1

Note

Step 2

Step 3

Step 4
Step 5

Step 6
Step 7
Step 8

Step 9

Step 10
Step 11
Step 12

Revised February 12, 2014

To Confirm Exchange 2013 Authentication and SSL Settings for Cisco Unity Connection

Decide which type of authentication (basic or NTLM) you want Unity Connection to use to sign in to
Exchange 2013 client access servers (Unity Connection 8.6(2) SU3 and later). You must configure the
following servers to use the same type of authentication:

e All Exchange 2013 client access servers (Unity Connection 8.6(2) SU3 and later).

Unity Connection 8.6.2(a) SU4 now supports NTLMv2 for Unified Messaging.

Decide whether you want the communication between Unity Connection and Exchange 2013 client
access servers (Unity Connection8.6(2) SU3 and later) to be SSL encrypted. If so, you must specify the
same SSL setting on the following servers:

e All Exchange 2013 client access servers (Unity Connection 8.6(2) SU3 and later).

Sign in to a server that has access to the same Exchange 2013 client access servers (Unity Connection
8.6(2) SU3 and later) that Unity Connection has. Use an account that is a member of the local
Administrators group.

On the Windows Start menu, select Programs > Administrative Tools > Internet Information
Services (IIS) Manager.

For the first Exchange 2013 client access server (Unity Connection 8.6(2) SU3 and later) for which you
want to confirm settings, in the left pane, expand <servername> > Sites > Default Website > EWS.

Under Default Website, select Autodiscover.
In the middle pane, in the IIS section, double-click Authentication.

Confirm that the Status column says Enabled for the type of authentication that you want the unified
messaging services account to use to sign in to Exchange client access servers. When you create a unified
messaging services account, you will configure Unity Connection to use the same type of authentication.

Unity Connection supports only the following types of authentication:
e Basic
e NTLM

If you changed any settings, in the right pane, select Apply.

In the left pane, select Autodiscover again.

In the middle pane, double-click SSL Settings.

If the Require SSL check box is checked:

e When you create a unified messaging service in Unity Connection, you must choose HTTPS for the
web-based protocol.
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¢  You must download SSL certificates from the Exchange server and install them on the Unity
Connection server.

Step13  If you changed any settings, in the right pane, select Apply.
Step14  In the left pane, under Default Website, select EWS.
Step15 In the middle pane, in the IIS section, double-click Authentication.

Step16  Confirm that the Status column says Enabled for the type of authentication that you want the unified
messaging services account to use to sign in to Exchange mailboxes. When you create a unified
messaging services account, you will configure Unity Connection to use the same type of authentication.

A

Caution  The unified messaging services account must use the same type of authentication for EWS
that you specified for autodiscover in Step 8.

Unity Connection supports only the following types of authentication:
e Basic
e NTLM
Step17 If you changed any settings, in the right pane, select Apply.
Step 18  In the left pane, select EWS again.
Step19 In the middle pane, double-click SSL Settings.
Step20 If the Require SSL check box is checked:

¢ You must choose HTTPS for the web-based protocol when you create a unified messaging service
in Unity Connection.

¢ You must download SSL certificates from the Exchange server and install them on the Unity
Connection server.

A

Caution  The unified messaging services account must use the same SSL settings for EWS that you
specified for autodiscover in Step 12.

Step21 If you changed any settings, in the right pane, select Apply.

Step22 Repeat Step 5 through Step 22 for the other Exchange 2013 client access servers (Unity Connection
8.6(2) SU3 and later) that Unity Connection can access.

Step23 Close IIS Manager.

Confirming Exchange 2010 Authentication and SSL Settings

To Confirm Exchange 2010 Authentication and SSL Settings

Step1  Decide which type of authentication (basic, digest, or NTLM) you want Unity Connection to use to sign
in to Exchange 2010 client access servers. You must configure the following servers to use the same type
of authentication:

e All Exchange 2010 client access servers.
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Step 2

Step 3

Step 4

Step 5

Step 6
Step 7
Step 8

Step 9

Step 10
Step 11
Step 12

Step 13
Step 14
Step 15

Confirming Exchange Authentication and SSL Settings 1l

e All Exchange 2007 client access servers, if there are Exchange 2007 mailboxes that you want Unity
Connection to be able to access.

e All Exchange 2003 servers, if any, on which there are mailboxes that you want Unity Connection to
be able to access.

Decide whether you want the communication between Unity Connection and Exchange 2010 client
access servers to be SSL encrypted. If so, you must specify the same SSL setting on the following
servers:

e All Exchange 2010 client access servers.

¢ All Exchange 2007 client access servers, if there are Exchange 2007 mailboxes that you want Unity
Connection to be able to access.

e All Exchange 2003 servers, if any, on which there are mailboxes that you want Unity Connection to
be able to access.

Sign in to a server that has access to the same Exchange 2010 client access servers that Unity Connection
has. Use an account that is a member of the local Administrators group.

On the Windows Start menu, select Programs > Administrative Tools > Internet Information
Services (IIS) Manager.

For the first Exchange 2010 client access server for which you want to confirm settings, in the left pane,
expand <servername> > Sites > Default Website.

Under Default Website, select Autodiscover.
In the middle pane, in the IIS section, double-click Authentication.

Confirm that the Status column says Enabled for the type of authentication that you want the unified
messaging services account to use to sign in to Exchange client access servers. When you create a unified
messaging services account, you will configure Unity Connection to use the same type of authentication.

Unity Connection supports only the following types of authentication:
e Basic
¢ Digest
e NTLM

N

Note NTLM vl is supported with Single Inbox Feature. Cisco Unity Connection 8.6.2 SU3
supports both NTLM and NTLMv?2.

If you changed any settings, in the right pane, select Apply.
In the left pane, select Autodiscover again.

In the middle pane, double-click SSL Settings.

If the Require SSL check box is checked:

e When you create a unified messaging service in Unity Connection, you must choose HTTPS for the
web-based protocol.

¢ You must download SSL certificates from the Exchange server and install them on the Unity
Connection server.

If you changed any settings, in the right pane, select Apply.
In the left pane, under Default Website, select EWS.

In the middle pane, in the IIS section, double-click Authentication.
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Step 16

Step 17
Step 18
Step 19
Step 20

Step 21
Step 22

Step 23

Step 24

Confirm that the Status column says Enabled for the type of authentication that you want the unified
messaging services account to use to sign in to Exchange mailboxes. When you create a unified
messaging services account, you will configure Unity Connection to use the same type of authentication.

A

Caution  The unified messaging services account must use the same type of authentication for EWS
that you specified for autodiscover in Step 8.

Unity Connection supports only the following types of authentication:

e Basic
¢ Digest
e NTLM

If you changed any settings, in the right pane, select Apply.
In the left pane, select EWS again.

In the middle pane, double-click SSL Settings.

If the Require SSL check box is checked:

¢ You must choose HTTPS for the web-based protocol when you create a unified messaging service
in Unity Connection.

¢ You must download SSL certificates from the Exchange server and install them on the Unity
Connection server.

A

Caution  The unified messaging services account must use the same SSL settings for EWS that you
specified for autodiscover in Step 12.

If you changed any settings, in the right pane, select Apply.
If you have installed Exchange 2010 Service Pack 1 or later, skip to Step 23.

If you have not installed Exchange 2010 Service Pack 1 or later, edit the Exchange web.config files for
EWS and for autodiscovery to match the settings in IIS Manager:

e For EWS, see “Enable or Disable SSL on Exchange Web Services Virtual Directories” on the
Microsoft Technet website. Search on the document title.

¢ No comparable document exists for autodiscovery, but you can use the applicable procedure in the
EWS document to edit the web.config file in the \Exchange Server\V 14\ClientAccess\Autodiscover
directory.

Repeat Step 5 through Step 22 for the other Exchange 2010 client access servers that Unity Connection
can access.

Close IIS Manager.
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Confirming Exchange 2007 Authentication and SSL Settings

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6
Step 7
Step 8
Step 9

Step 10
Step 11
Step 12

To Confirm Exchange 2007 Authentication and SSL Settings

Decide which type of authentication (basic, digest, or NTLM) you want Unity Connection to use to sign
in to Exchange 2007 client access servers. You must configure the following servers to use the same type
of authentication:

¢ All Exchange 2007 client access servers.

e All Exchange 2010 client access servers, if there are Exchange 2010 mailboxes that you want Unity
Connection to be able to access.

e All Exchange 2003 servers, if any, on which there are mailboxes that you want Unity Connection to
be able to access.

Decide whether you want the communication between Unity Connection and Exchange 2007 client
access servers to be SSL encrypted. If so, you must specify the same SSL setting on the following
servers:

e All Exchange 2007 client access servers.

¢ All Exchange 2010 client access servers, if there are Exchange 2010 mailboxes that you want Unity
Connection to be able to access.

e All Exchange 2003 servers, if any, on which there are mailboxes that you want Unity Connection to
be able to access.

Sign in to a server that has access to the same Exchange 2007 client access servers as Unity Connection
has. Use an account that is a member of the local Administrators group.

On the Windows Start menu, select Programs > Administrative Tools > Internet Information
Services (IIS) Manager.

For the first Exchange 2007 server for which you want to confirm settings, in the left pane, expand
<servername> > Sites > Default Website.

Under Default Website, right-click Autodiscover, and select Properties.
In the Autodiscover Properties dialog box, select the Directory Security tab.
In the Authentication and Access Control section, select Edit.

In the Authentication Methods dialog box, confirm that the check box is checked for the type of
authentication that you want the unified messaging services account to use to find Exchange servers.
When you create a unified messaging services account, you will configure Unity Connection to use the
same type of authentication.

Unity Connection supports only the following types of authentication:
e Basic
¢ Digest
e NTLM

Select OK.

In the Secure Communications section, select Edit.

In the Secure Communications dialog box, if the Require Secure Channel (SSL) check box is
checked:

e You must choose HTTPS for the web-based protocol when you create a unified messaging service
in Unity Connection.
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¢  You must download SSL certificates from the Exchange server and install them on the Unity
Connection server.

Step13  Select OK twice.

Step14  In the left pane, under Default Website, right-click EWS, and select Properties.
Step15 In the EWS Properties dialog box, select the Directory Security tab.

Step16 In the Authentication and Access Control section, select Edit.

Step17 In the Authentication Methods dialog box, confirm that the check box is checked for the type of
authentication that you want the unified messaging services account to use to find Exchange servers.
When you create a unified messaging services account, you will configure Unity Connection to use the
same type of authentication.

A

Caution  The unified messaging services account must use the same type of authentication for EWS
that you specified for autodiscover in Step 9.

Unity Connection supports only the following types of authentication:
e Basic
e Digest
e NTLM
Step18 Select OK.
Step19 In the Secure Communications section, select Edit.

Step20 In the Secure Communications dialog box, if the Require Secure Channel (SSL) check box is
checked:

¢ You must choose HTTPS for the web-based protocol when you create a unified messaging service
in Unity Connection.

¢  You must download SSL certificates from the Exchange server and install them on the Unity
Connection server.

A

Caution  The unified messaging services account must use the same SSL settings for EWS that you
specified for autodiscover in Step 12.

Step21 Select OK twice.

Step22 Repeat Step 5 through Step 21 for the other Exchange 2007 client access servers that Unity Connection
can access.

Step23 Close IIS Manager.

Confirming Exchange 2003 Authentication and SSL Settings

To Confirm Exchange 2003 Authentication and SSL Settings

Step1  Decide which type of authentication (basic, digest, or NTLM) you want Unity Connection to use to sign
in to Exchange 2003 servers.
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Step 2

Step 3

Step 4

Step 5

Step 6
Step 7
Step 8
Step 9

Step 10
Step 11

Confirming Exchange Authentication and SSL Settings 1l

If you are configuring Unity Connection to search for Exchange servers, you must configure the
following servers to use the same type of authentication:

e All Exchange 2003 servers, if any, on which there are mailboxes that you want Unity Connection to
be able to access.

e All Exchange 2007 client access servers.

¢ All Exchange 2010 client access servers, if there are Exchange 2010 mailboxes that you want Unity
Connection to be able to access.

If you are choosing specific Exchange servers, you do not need to configure all Exchange servers to use
the same type of authentication. Each Exchange server is associated with a separate unified messaging
service, so the Exchange authentication mode only needs to match the authentication mode for the
corresponding unified messaging service.

N

Note If you are choosing a specific Exchange 2003 front-end server, you may need to use basic
authentication. For more information, on the Microsoft website, see the “Authentication
Mechanisms for HTTP” in the Exchange Server 2003 section of the TechNet Library.

Decide whether you want the communication between Unity Connection and Exchange 2007 client
access servers to be SSL encrypted. If so, you must specify the same SSL setting on the following
servers:

e All Exchange 2003 servers, if any, on which there are mailboxes that you want Unity Connection to
be able to access.

e All Exchange 2007 client access servers.

e All Exchange 2010 client access servers, if there are Exchange 2010 mailboxes that you want Unity
Connection to be able to access.

Sign in to a server that has access to the same Exchange 2003 servers as Unity Connection has. Use an
account that is a member of the local Administrators group.

On the Windows Start menu, select Programs > Administrative Tools > Internet Information
Services (IIS) Manager.

For the first Exchange 2003 server for which you want to confirm settings, in the left pane, expand
<servername> > Web Sites > Default Website.

Under Default Website, right-click Exchange, and select Properties.
In the Exchange Properties dialog box, select the Directory Security tab.
In the Authentication and Access Control section, select Edit.

In the Authentication Methods dialog box, confirm that the check box is checked for the type of
authentication that you want the unified messaging services account to use to sign in to Exchange
servers. When you create a unified messaging service, you will configure Unity Connection to use the
same type of authentication.

Unity Connection supports only the following types of authentication:

e Basic

e Digest

e NTLM
Select OK.

In the Secure Communications section, select Edit.
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Step 12

Step 13
Step 14

Step 15

In the Secure Communications dialog box, if the Require Secure Channel (SSL) check box is
checked:

e You must choose HTTPS for the web-based protocol when you create a unified messaging service
in Unity Connection.

¢ You must download SSL certificates from the Exchange server and install them on the Unity
Connection server.

Select OK twice.

Repeat Step 5 through Step 13 for the other Exchange 2003 servers that you want Unity Connection to
be able to access.

Close IIS Manager.

Creating the Unified Messaging Services Account in Active
Directory and Granting Permissions

Unity Connection accesses Exchange mailboxes by using an Active Directory account called the unified
messaging services account. After you create the account, you grant it the rights necessary for Unity
Connection to perform operations on behalf of the user. For Exchange 2010 and 2007, operations are
performed through Exchange Web Services (EWS). For Exchange 2003, operations are performed
through WebDav. These operations include uploading messages into Exchange mailboxes, tracking
changes to the messages in Exchange, updating the messages with changes made in Unity Connection,
deleting messages in Exchange when the messages are deleted in Unity Connection, tracking when
messages are deleted in Exchange so they can be moved to the deleted items folder in Unity Connection,
and so on.

See the following sections:
e Task list for Creating the Unified Messaging Services Account and Granting Permissions, page 2-28

e Confirming that Local Computer Account is a Member of the Windows Authorization Access Group
on Client Access Servers(Exchange 2007 Only), page 2-29

e Assigning the Application Impersonation Management Role to Unified Messaging Services
Accounts (Exchange 2013 and Exchange 2010 Only), page 2-30

e Granting Rights to the Unified Messaging Services Account (Exchange 2007 Only), page 2-31
e Granting Permissions to the Unified Messaging Services Account (Exchange 2003 Only), page 2-32

Task list for Creating the Unified Messaging Services Account and Granting

Permissions

1. Create one or more domain user accounts in the Active Directory forest that includes the Exchange
servers with which you want Unity Connection to communicate. Note the following:

— Give the account a name that identifies it as the unified messaging services account for Unity
Connection.

— Do not create an Exchange mailbox for the account.
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A

Caution  If you create a mailbox for the account, unified messaging will not function properly.

— Do not add the account to any administrator group.
— Do not disable the account, or Unity Connection cannot use it to access Exchange mailboxes.
— Specify a password that satisfies the password-security requirements of your company.

The password is encrypted with AES 128-bit encryption and stored in the Unity Connection
database. The key that is used to encrypt the password is accessible only with root access, and
root access is available only with assistance from Cisco TAC.

— When you are configuring unified messaging for a Unity Connection cluster, Unity Connection
automatically uses the same unified messaging services account for both Unity Connection
Servers.

— When you are configuring unified messaging for intersite networking or for intrasite
networking, you can use the same unified messaging services account for more than one Unity
Connection server. However, this is not a requirement and does not affect functionality or
performance.

2. Ifyou are using Exchange 2007: For all client access servers, confirm that the local computer
account is a member of the Windows Authorization Access group. See the “Confirming that Local
Computer Account is a Member of the Windows Authorization Access Group on Client Access
Servers(Exchange 2007 Only)” section on page 2-29.

3. For each version of Exchange that you want Unity Connection to be able to access, do the procedure
in the corresponding section:

— Assigning the Application Impersonation Management Role to Unified Messaging Services
Accounts (Exchange 2013 and Exchange 2010 Only), page 2-30

— Granting Rights to the Unified Messaging Services Account (Exchange 2007 Only), page 2-31

— Granting Permissions to the Unified Messaging Services Account (Exchange 2003 Only),
page 2-32

Confirming that Local Computer Account is a Member of the Windows
Authorization Access Group on Client Access Servers(Exchange 2007 Only)

Step 1

Step 2
Step 3

Step 4

If you are configuring unified messaging for Unity Connection users whose Exchange mailboxes are
homed on Exchange 2007 servers, do the following procedure to confirm that the local computer
accounts for those servers are members of the Windows Authorization Access group, as they are by
default. Do the procedure for all Exchange 2007 client access servers that Unity Connection can access.

To Confirm that the Local Computer Account Is a Member of the Windows Authorization Access Group on Client
Access Servers (Exchange 2007 Only)

Sign in to a server on which Active Directory Users and Computers is installed. Use an account that is
a member of the Domain Admins group.

On the Windows Start menu, select Administrative Tools > Active Directory Users and Computers.

In the left pane, expand the name of a domain that contains Exchange 2007 client access servers that
Unity Connection can access, and select Builtin.

In the right pane, right-click Windows Authorization Access Group, and select Properties.
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Step 5
Step 6
Step 7
Step 8
Step 9
Step 10

Step 11
Step 12
Step 13
Step 14

In the Windows Authorization Access Group Properties dialog box, select the Members tab.
Select Add.

In the Select Users, Contacts, Computers, or Groups dialog box, select Object Types.
Check the Computers check box.

Select OK to close the Object Types dialog box.

On the Select Users, Contacts, Computers, or Groups dialog box, enter the names of all of the
Exchange 2007 client access servers in the domain that you expanded in Step 3.

Select Check Names.
Select OK to close the Select Users, Contacts, Computers, or Groups dialog box.
Select OK to close the Windows Authorization Access Group Properties dialog box.

Repeat Step 3 through Step 13 for the other domains that contain Exchange 2007 client access servers
that Unity Connection can access.

Assigning the Application Impersonation Management Role to Unified
Messaging Services Accounts (Exchange 2013 and Exchange 2010 Only)

Step 1

Step 2

Step 3

To Assign the Applicationlmpersonation Management Role to Unified Messaging Services Accounts (Exchange
2013 and Exchange 2010 Only)

Sign in to a server on which Exchange Management Shell is installed. Sign in by using either an account
that is a member of the Enterprise Admins group or an account that has permission to grant permissions
on Exchange objects in the configuration container.

Run the following command in Exchange Management Shell to assign the Applicationlmpersonation
management role to the unified messaging services account for Exchange 2013 (Unity Connection 8.6(2)
SU3 and later) or 2010.

new-ManagementRoleAssignment -Name:RoleName -Role:ApplicationImpersonation
-User:'Account’

where:

® RoleName is the name that you want to give the assignment, for example, Unity
ConnectionUMServicesAcct. The name that you enter for RoleName appears when you run
get-ManagementRole Assignment.

e Account is the name of the unified messaging services account in domain\alias format.

If you created more than one unified messaging services account, repeat Step 2 for the remaining
accounts. Specify a different value for RoleName for each unified messaging services account.
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Granting Rights to the Unified Messaging Services Account (Exchange 2007

Only)

Step 1

Step 2

Step 3

Step 4

To Grant Rights to the Unified Messaging Services Account (Exchange 2007 Only)

Sign in to a server on which Exchange Management Shell is installed. Sign in by using either an account
that is a member of the Enterprise Admins group or an account that has permission to grant rights on
Exchange objects in the configuration container.

Run the following commands in Exchange Management Shell to grant the required rights to the unified
messaging services account for Exchange 2007:

Add-ADPermission -Identity (PermissionLevel).DistinguishedName -User (Get-User -Identity
Account | select-object).identity -ExtendedRight ms-Exch-EPI-Impersonation

Add-ADPermission -Identity (PermissionLevel).DistinguishedName -User (Get-User -Identity
Account | select-object).identity -ExtendedRight ms-Exch-EPI-May-Impersonate

Add-ADPermission -Identity (PermissionLevel).DistinguishedName -User (Get-User -Identity
Account | select-object).identity -ExtendedRights Receive-As

where:

e PermissionLevel is determined by whether you want to grant the unified messaging services account
rights to access individual servers or rights to access all Exchange 2007 servers in the organization:

— To grant the unified messaging services account rights to access individual Exchange servers,
replace PermissionLevel with:

Get-ExchangeServer -Identity ServerName

where ServerName is the name of the Exchange 2007 server to which you want the unified
messaging services account to have access.

- To grant the unified messaging services account rights to access all Exchange 2007 servers in
the Exchange organization, replace PermissionLevel with:

Get-OrganizationConfig

For more information on the Add-ADPermission commandlet and the Identity parameter, see
Exchange 2007 Help.

e Account is the name of the unified messaging services account in domain\alias format.

If you created more than one unified messaging services account, repeat Step 2 for the remaining
accounts.

If you set permissions on individual Exchange server in Step 2 and you have more than one
Exchange 2007 server, repeat Step 1 through Step 3 on the following servers:

e All other Exchange 2007 client access servers that Unity Connection can access.

e All Exchange 2007 mailbox servers that home mailboxes that you want Unity Connection to be able
to access.
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Grant Unified Messaging Services Accounts the Permission to Sign In Locally (Exchange 2007 Only)

Step 1

Step 2
Step 3
Step 4
Step 5

Step 6

Step 7
Step 8
Step 9
Step 10
Step 11

On an Exchange 2007 client access server that Unity Connection can access, sign in by using an account
that is a member of the local Administrators group.

On the Windows Start menu, select Administrative Tools > Local Security Policy.
In the left pane, expand Local Policies, and select User Rights Assignment.
In the right pane, right-click Allow Log on Locally, and select Properties.

In the Allow Log on Locally Properties dialog box, on the Local Security Setting tab, select Add User
or Group.

On the Select Users, Computers, or Groups dialog box, enter the name of the unified messaging
services account that you created in Task 1. of the “Task list for Creating the Unified Messaging Services
Account and Granting Permissions” section on page 2-28.

If intrasite networking or intersite networking is configured, and if you created more than one unified
messaging services account, enter the names of the unified messaging services accounts for the Unity
Connection servers that will access this Exchange 2007 client access server.

Select Check Names.
Select OK to close the Select Users, Computers, or Groups dialog box.
Select OK to close the Allow Log on Locally Properties dialog box.
Close Local Security Settings.
Repeat Step 1 through Step 10 on the following servers:
e All other Exchange 2007 client access servers that Unity Connection can access.

e All Exchange 2007 mailbox servers that home mailboxes that you want Unity Connection to be able
to access.

Granting Permissions to the Unified Messaging Services Account
(Exchange 2003 Only)

Step 1

Step 2
Step 3
Step 4

Step 5
Step 6
Step 7

To Grant Permissions to the Unified Messaging Services Account (Exchange 2003 Only)

Sign in to a server on which Exchange System Manager is installed. Sign in by using either an account
that is a member of the Enterprise Admins group or an account that has permission to grant permissions
on Exchange objects in the configuration container.

On the Windows Start menu, select Programs > Microsoft Exchange > System Manager.
In the left pane, expand Servers.

Right-click the name of the Exchange server that contains mailboxes that will be accessed by
Cisco Unity Connection, and select Properties.

In the <Server name> Properties dialog box, select the Security tab.
Select Add.

In the Select Users, Computers, or Groups dialog box, in the Enter the Object Names to Select field,
enter the name of the unified messaging services account.
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Step 8
Step 9
Step 10

Step 11

Step 12
Step 13

Configuring EWS Limits for the Unified Messaging Services Account (Exchange 2013 and later)

Select Check Names.
Select OK to close the dialog box.

In the <Server name> Properties dialog box, in the Group or User Names list, select the name of the
unified messaging services account.

In the Permissions For <Account name> list, check the Allow check box for the following permissions:
¢ Send As
¢ Receive As
¢ Administer Information Store

Select OK to close the <Server name> Properties dialog box.

Repeat Step 4 through Step 12 for each additional Exchange server that you want to access.

Configuring EWS Limits for the Unified Messaging Services
Account (Exchange 2013 and later)

Note

Step 1

Step 2

Step 3

If any Unity Connection users who are configured for unified messaging have mailboxes in Exchange
2013(8.6(2), remove the Exchange 2013 EWS limits for the unified messaging service account by
creating and applying a new mailbox policy to the target mailbox account. If you do not remove EWS
limits, messages may not be synchronized, and status changes (for example, from unread to read),
changes to the subject line, and changes to the priority may not be replicated. In addition, attempts to
access Exchange calendars and contacts may fail.

Prior to Exchange 2013, the throttling limit was calculated against the calling account (in our case
service account). Starting with Exchange 2013(Unity Connection 8.6(2) SU3 and later), this limit has
been changed. Now the charges are counted against the target mailbox rather than the calling account.

To Remove EWS Limits for the Unified Messaging Services Account for Cisco Unity Connection (Exchange 2013
and later)

Sign in to a server on which Exchange Management Shell is installed. Sign in by using either an account
that is a member of the Enterprise Admins group or an account that has permission to grant permissions
on Exchange objects in the configuration container.

Create a new policy with unlimited EWS connections:

New-ThrottlingPolicy -Name " <ConnectionUnifiedMessagingServicesPolicy>""
-EWSMaxConcurrency unlimited -EWSMaxBurst unlimited -EWSRechargeRate unlimited
-EWSCutOffBalance unlimited -EWSMaxSubscriptions unlimited

where ConnectionUnifiedMessagingServicesPolicy is the name that you want to assign to the policy.

Apply the new policy to the unified messaging services user mailbox. For each user mailbox, run the
following command:

Set-ThrottlingPolicyAssociation -Identity ''<ConnectionUnifiedMessagingusermailbox>""
-ThrottlingPolicy ''<ConnectionUnifiedMessagingServicesPolicy>""

where:
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Note

Step 4

Step 5

e ConnectionUnifiedMessagingusermailbox is the name of the user mailbox.

e ConnectionUnifiedMessagingServicesPolicy is the name of the policy that you created in Step 2.

The Set-ThrottlingPolicyAssociation command is not supported with Exchange 2010 version
14.00.0639.021. The users having Exchange 2010 with version 14.00.0639.021 are not allowed to
modify an existing throttling policy settings, hence the default policy gets applied here.

Confirm that the mailbox is using the new policy:

Get-ThrottlingPolicyAssociation -Identity ''<ConnectionUnifiedMessagingusermailbox>" | findstr
"ThrottlingPolicy"

On each Exchange 2013 (Unity Connection 8.6(2) SU3 and later) server that has the CAS role, restart
the Microsoft Exchange RPC Client Access service.

Configuring EWS Limits for the Unified Messaging Users
(Exchange 2010 SP2 RU4 and Later)

Note

Microsoft has enabled the client throttling policy feature by default. If there is no throttling policy
already configured, Microsoft Exchange applies a default policy to all users. The default throttling
policy is tailored for end user's load and not for an enterprise application like, Cisco Unity Connection
using impersonation. If any Cisco Unity Connection users who are configured for unified messaging
have mailboxes in Exchange 2010, configure the Exchange 2010 EWS limits for the unified messaging
users mailbox by creating and applying a new mailbox policy to the unified messaging user mailbox
account. If you do not configure EWS limits, messages may not be synchronized, and status changes (for
example, from unread to read), changes to the subject line, and changes to the priority may not be
replicated. In addition, attempts to access Exchange calendars and contacts may fail.

After Exchange 2010 SP2 RU4, when Exchange impersonation is used, the budgets for all the throttling
thresholds calculated against the account that is impersonated (target mailbox) and not the impersonating
account (Unified Messaging Service Account).

For Unity Connection Versions 8.5.1 SU6 and Later or Unity Connection Versions
8.6(2) SU4 and Later

Step 1

Make sure to enable the paged view search functionality. To enable the paged view functionality for
messages, you must set the value of the 'System.Messaging. MbxSynch.MbxSynchUsePaging' parameter
to 1.

To Enable the Paged View Functionality, Perform the Following Steps

Run the following CLI command:

run cuc dbguery unitydirdb execute procedure
csp_ConfigurationModifyBool (pFullName="'System.Messaging.MbxSynch.MbxSynchUsePaging', pvalue
=1)
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Note

Step 2

Configuring EWS Limits for the Unified Messaging Users (Exchange 2010 SP2 RU4 and Later) I

When a Cisco Unity Connection cluster is configured, you can run the command on publisher or
subscriber server.

To set the maximum limit of voice messages items that can be managed by Cisco Unity Connection with
the Paged view search functionality, run the following CLI command:

run cuc dbguery unitydirdb execute procedure

csp_ConfigurationModify (pFullName="'System.Messaging.MbxSynch.MbxSynchVoiceMailCountLimit',
pvalue="newvalue")

where, new value specifies the value of the voicemails count limit that you can view after the paging
parameter is enabled. Cisco Unity Connection by default manages the first 25000 voice messages per
mailbox that avoid any delay in message synchronization between Unity Connection and Exchange
server. This voicemail count limit can be increased maximum up to 75000.

For Unity Connection Versions Previous to 8.5.1 SU6 or Unity Connection
Versions Previous to 8.6(2) SU4

)

Note

Step 1

Step 2

Step 3

For the Unity Connection versions previous to 8.5.1 SU6 or Connection versions previous to 8.6(2) SU4,
configure the EWS limits for affected unified users by following the below given steps.

These steps are also applicable if the paged view search functionality is disabled.

To Configure EWS Limits for the Unified Messaging Users for Cisco Unity Connection (Exchange 2010 Service
Pack 2 RU4 and Later)

Sign in to a server on which Exchange Management Shell is installed. Sign in by using either an account
that is a member of the Enterprise Admins group or an account that has permission to grant permissions
on Exchange objects in the configuration container.

Create a new policy with the following EWS connections where Exchange mailboxes have more than
1000 messages, which includes voice messages and receipts. For Exchange mailboxes having 10000
messages, then the new throttling policy will be:

New-ThrottlingPolicy -Name " <ConnectionUnifiedMessagingServicesPolicy>""
-EWSPercentTimeInCAS 300 -EWSPercentTimeInMailboxRPC 200 -EWSFindCountLimit 10000
-EWSPercentTimeinAD 100

where ConnectionUnifiedMessagingServicesPolicy is the name that you want to assign to the policy.
Refer to the Table 2-5 to have detailed description on the throttling policy parameters.

Apply the new policy to all the unified messaging user mailbox. For each user mailbox, run the following
command:

Set-ThrottlingPolicyAssociation -Identity ''<ConnectionUnifiedMessagingusermailbox>""
-ThrottlingPolicy '"<ConnectionUnifiedMessagingServicesPolicy>""

where:
e ConnectionUnifiedMessagingusermailbox is the name of the user mailbox.

e ConnectionUnifiedMessagingServicesPolicy is the name of the policy that you created in Step 2.
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Stepd  Confirm that the mailbox is using the new policy:

Get-ThrottlingPolicyAssociation -Identity ''<ConnectionUnifiedMessagingusermailbox>" | findstr

"ThrottlingPolicy"
Step5  Oneach Exchange 2010 server that has the CAS role, restart the Microsoft Exchange RPC Client Access
service.
Table 2-5 Recommended Throttle Policy Parameter Values With 10000 Items in User's Mailbox

Field Policy Value To Be Used |Description

EWSPercentTimeInCAS 300 Specifies the percentage of a minute
that an Exchange Web Services user
can spend executing the client
access server code
(PercentTimeInCAS).

EWSPercentTimeInMailboxRPC 200 Specifies the percentage of a minute

that an Exchange Web Services user
can spend executing mailbox remote
procedure call (RPC) requests
(PercentTimeInMailboxRPC).

EWSFindCountLimit 10000 Defines the maximum number of
items from a FindItem or FindFolder
operation that can exist in memory
on the Client Access server at one
time for one user.

Note If in your deployment
mailboxes have more than
10,000 items, then you can
adjust this parameter.

EWSPercentTimeinAD 100 Specifies the maximum amount of
time that can be spent by a Client
Access server when accessing
Active Directory resources on
behalf of a client account, per
minute.

Configuring EWS Limits for the Unified Messaging Services
Account for Cisco Unity Connection (Exchange 2010 SP2 RU3
and Earlier Releases)

Revised September 23, 2013

If any Unity Connection users who are configured for unified messaging have mailboxes in Exchange
2010, configure the Exchange 2010 EWS limits for the unified messaging service account by creating
and applying a new mailbox policy to the unified messaging services account. If you do not configure
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Note

Step 1

Step 2

Step 3

Note

Step 4

Step 5

Step 6

Configuring EWS Limits for the Unified Messaging Services Account for Cisco Unity Connection (Exchange 2010 SP2

EWS limits, messages may not be synchronized, and status changes (for example, from unread to read),
changes to the subject line, and changes to the priority may not be replicated. In addition, attempts to
access Exchange calendars and contacts may fail.

Prior to Exchange 2010 Service Pack 1, EWS limits were off by default. If you have not yet installed
Service Pack 1, which turns limits on by default, we still recommend that you do the following
procedure. Otherwise, when you install Service Pack 1, Unity Connection functionality will be affected.

To Configure EWS Limits for the Unified Messaging Services Account for Cisco Unity Connection (Exchange 2010
SP2 RU3 and Earlier Releases)

Sign in to a server on which Exchange Management Shell is installed. Sign in by using either an account
that is a member of the Enterprise Admins group or an account that has permission to grant permissions
on Exchange objects in the configuration container.

Create a new policy with unlimited EWS connections:

New-ThrottlingPolicy -Name "' <ConnectionUnifiedMessagingServicesPolicy>"
-EWSMaxConcurrency $null -EWSMaxSubscriptions $null -EWSPercentTimeInCAS $null
-EWSPercentTimeInMailboxRPC $null -EWSFindCountLimit $null -EWSPercentTimeinAD
$null

where ConnectionUnifiedMessagingServicesPolicy is the name that you want to assign to the policy.
Apply the new policy to the unified messaging services account and the user mailbox:

Set-ThrottlingPolicyAssociation -Identity '"<ConnectionUnifiedMessagingServicesAccount>""
-ThrottlingPolicy '"<ConnectionUnifiedMessagingServicesPolicy>""

where:

e ConnectionUnifiedMessagingServicesAccount is the name of the account that you created in the
“Creating the Unified Messaging Services Account in Active Directory and Granting Permissions”
section on page 2-28.

e ConnectionUnifiedMessagingServicesPolicy is the name of the policy that you created in Step 2.

The Set-ThrottlingPolicyAssociation command is not supported with Exchange 2010 version
14.00.0639.021. The users having Exchange 2010 with version 14.00.0639.021 are not allowed to
modify an existing throttling policy settings, hence the default policy gets applied here.

Confirm that the mailbox is using the new policy:

Get-ThrottlingPolicyAssociation -Identity ''<ConnectionUnifiedMessagingServicesAccount>" |
findstr ""ThrottlingPolicy"

If you created more than one unified messaging services account, repeat Step 3 and Step 4 for the
remaining accounts.

On each Exchange 2010 server that has the CAS role, restart the Microsoft Exchange RPC Client Access
service.
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Enabling the WebDav Service on Exchange 2003 Servers for
Cisco Unity Connection 8.5 and Later

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

If you want Unity Connection to access mailboxes on Exchange 2003 servers, you need to configure
Internet Information Services to allow the WebDav service. Do the following procedure.

To Enable the WebDav Service on Exchange 2003 for Cisco Unity Connection 8.5

Sign in to a server that has access to the same Exchange 2003 servers that the Unity Connection server
has access to. Use an account that is a member of the local Administrators group.

On the Windows Start menu, select Programs > Administrative Tools > Internet Information
Services (IIS) Manager.

For the first Exchange 2003 server for which you want to confirm settings, in the left pane, expand
<servername> and select Web Service Extensions.

In the right pane, for WebDAYV, check the value of the Status column:
e If the value is Allowed, skip to Step 5.
e If the value is Prohibited, select Allow.

Repeat Step 3 and Step 4 for the other Exchange 2003 servers that you want Unity Connection to be able
to access.

Close IIS Manager.

Creating a Unified Messaging Service to Access Exchange from
Cisco Unity Connection 8.5 and Later

Step 1

Step 2
Step 3

Step 4
Step 5

Revised February 3, 2011
Do the following procedure to create one or more unified messaging services.

To Create a Unified Messaging Service to Access Exchange from Cisco Unity Connection 8.5

In Cisco Unity Connection Administration, expand Unified Messaging, then select Unified Messaging
Services.

On the Search Unified Messaging Services page, select Add New.

Decide which options to select for the Message Action for Email and Message Action for Fax lists at
the bottom of the page. (For field information, on the Help menu, select This Page.)

If you want to select Relay the Message or Accept and Relay the Message for either list, you must first
configure an SMTP Smart Host on the System Settings > SMTP Configuration > Smart Host page.
Unity Connection Administration will not let you save a new unified messaging configuration with those
settings when no SMTP Smart Host is configured.

On the New Unified Messaging Service page, in the Type list, select Exchange/BPOS -D.
Check the Enabled check box to enable the service.
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Step 6

Step 7

Step 8

Step 9

Step 10

Creating a Unified Messaging Service to Access Exchange from Cisco Unity Connection 8.5 and Later

For information on synchronization behavior if you later disable a unified messaging service for which
single inbox is enabled, see the “How Disabling and Re-enabling Single Inbox Affects the
Synchronization of Unity Connection and Exchange Mailboxes” section on page 2-10.

In the Display Name field, enter a descriptive name.

If you are creating more than one unified messaging service for Exchange, note that this is the name that
will appear on the Users > Unified Messaging Accounts page when you configure users for unified
messaging. Enter a display name that will simplify choosing the correct unified messaging service for
each user.

In the Web-Based Authentication Mode list, select the same authentication mode that you confirmed
when you did the applicable procedures in the “Confirming Exchange Authentication and SSL Settings”
section on page 2-20.

In the Web-Based Protocol list, select the same web-based protocol that you confirmed when you did
the applicable procedures in the “Confirming Exchange Authentication and SSL Settings” section on
page 2-20.

If you want Unity Connection to validate the SSL certificate from the Exchange server, check the
Validate Certificates for Exchange Servers check box.

Self-signed certificates cannot be validated. If you selected HTTPS from the Web-Based Protocol list,
and if you are using self-signed certificates, do not check the Validate Certificates for Exchange
Servers check box. If you do check the check box, Unity Connection will not be able to access
Exchange.

In the Exchange servers section, if you want Unity Connection to access a specific Exchange server, skip
to Step 11.

If you want Unity Connection to automatically find Exchange 2010 or Exchange 2007 client access
servers, or Exchange 2003 servers, do the following:

a. Select Search for Exchange Servers.

b. In the Active Directory DNS Domain Name field, enter the DNS domain name of the Active
Directory domain in which you want Unity Connection to begin searching for Exchange servers.

c. If you have Exchange servers in more than one Active Directory site, you can improve performance
if you specify the site that contains the domain controllers that you want Unity Connection to use to
find Exchange servers. In the Active Directory Site Name field, enter the name of the site.

d. Under Exchange Versions, select the versions of Exchange in which you have mailboxes that you
want Unity Connection to be able to access.

e. In the Protocol Used to Communicate with Domain Controllers list, select whether Unity
Connection should use LDAP or secure LDAP (LDAPS) when communicating with Active
Directory to find Exchange servers.

A

Caution = When you select Search for Exchange Servers, Unity Connection communicates with Active
Directory servers using Basic authentication regardless of the authentication method you
selected in the Web-Based Authentication Mode list. As a result, the username and password
of the unified messaging services account and all other communication between the Unity
Connection and Active Directory servers is in clear text. If you want this data to be encrypted,
you must select Secure LDAP (LDAPS) in the Protocol Used to Communicate with Domain
Controllers list and upload certificates from the certification authority that issued the SSL
certificates for Active Directory servers to both tomcat-trust and Connection-trust locations.
See Task 17. in the “Task List for Configuring Cisco Unity Connection 8.5 and Later and
Exchange for Unified Messaging” section on page 2-11.
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f. If you want Unity Connection to validate the SSL certificate from Active Directory domain
controllers, check the Validate Certificates for Active Directory Domain Controllers check box.

Self-signed certificates cannot be validated. If you selected LDAPS from the Protocol Used to
Communicate with Domain Controllers list, and if you are using self-signed certificates, do not
check the Validate Certificates for Active Directory Domain Controllers check box. If you do
check the check box, Unity Connection will not be able to access domain controllers to search for
Exchange servers.

g. Skip to Step 12.
Step11  To configure Unity Connection to access a specific Exchange server, do the following:
a. Select Specify an Exchange Server.

b. In the Exchange Server field, enter the fully qualified domain name or the IP address of the
Exchange server that you want Unity Connection to access. If you are entering the name of an
Exchange 2013 (Unity Connection 8.6(2) SU3 and later), Exchange 2010, or Exchange 2007 CAS
server, you must enter the name of a client access server.

c. Inthe Exchange Server Type list, select the version of Exchange installed on the server that you
specified in Step b.

Step12 In the Username and Password fields, enter the Active Directory username and password for the account
that you created in the “Creating the Unified Messaging Services Account in Active Directory and
Granting Permissions” section on page 2-28.

If you specify the username in domain\username format, do not use FQDN format for the domain name.
Step13  Under Service Capabilities, select the features that you want this unified messaging service to allow.

~

Note  When you configure unified messaging for Unity Connection users, you can disable for an
individual user any feature that you enable here. However, you cannot enable for an individual
user any feature that you disable here.

For information on synchronization behavior if you later disable a unified messaging service for which
single inbox is enabled, see the “How Disabling and Re-enabling Single Inbox Affects the
Synchronization of Unity Connection and Exchange Mailboxes” section on page 2-10.

Step14 Under Synchronize Connection and Exchange Mailboxes (Single Inbox), choose message actions for
email and for fax. (For field information, on the Help menu, select This Page.)

Step15 Select Save.

N

Note If you selected HTTPS in the Web-Based Protocol list, or if you selected Secure LDAP
(LDAPS) in the Protocol Used to Communicate with Domain Controllers list, you cannot test
the configuration until after you have uploaded SSL certificates in Task 17. of the “Task List for
Configuring Cisco Unity Connection 8.5 and Later and Exchange for Unified Messaging”
section on page 2-11 because the security-related tests will fail.

Step16 If you are configuring Unity Connection to communicate with individual Exchange servers, repeat
Step 2 through Step 15 to create additional unified messaging services as explained in the “Determining
which Exchange Servers You Want Cisco Unity Connection 8.5 and Later to Communicate with” section
on page 2-17.
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Uploading CA Public Certificates for Exchange and Active
Directory Servers

When you created unified messaging services, if you selected the option to validate certificates for
Exchange servers or for Active Directory domain controllers (DCs), you must upload the public
certificates from the certification authority (CA) that signed the certificates on the Exchange servers and
DCs. Otherwise, Unity Connection cannot communicate with Exchange servers or with DCs to find
Exchange servers, and unified messaging functionality will not work. Do the following tasks:

1.

If you selected the option to validate certificates for Exchange servers, and if SSL certificates are
not already installed on all of the following servers: Get and install certificates:

— Exchange 2013 (Unity Connection 8.6(2) SU3 and later) or Exchange 2010 client access
servers.

— Exchange 2007 client access servers, if there are Exchange 2007 mailboxes that you want Unity
Connection to be able to access.

— Exchange 2003 servers, if any, on which there are mailboxes that you want Unity Connection
to be able to access.

In addition, if you selected the option to validate certificates for Active Directory domain
controllers, and if SSL certificates are not already installed on your DCs, get and install certificates.

If you used an external CA (for example, Verisign) to issue the SSL certificates installed on the
servers listed in Task 1., and if you have the public certificates for the CA in .pem format: Save the
files to a network location accessible to the Unity Connection server. Then skip to Task 6.

If you used Microsoft Certificate Services or Active Directory Certificate Services to issue the SSL
certificates, or if you used an external CA and you do not have the public certificate for the CA in
.pem format: Download and install OpenSSL or another application that can convert public
certificates to .pem format. Unity Connection cannot upload public certificates in other formats.

If you used Microsoft Certificate Services to issue the SSL certificates: Do the “To Save the Public
Certificate for Microsoft Certificate Services or Active Directory Certificate Services to a File”
section on page 2-41.

If you used Microsoft Certificate Services, Active Directory Certificate Services, or an external CA,
and if you do not have public certificates in .pem format: Use the application that you downloaded
in Task 3. to convert the public certificate to .pem format, and save the file to a network location
accessible to the Unity Connection server.

Upload the public certificates to the Unity Connection server. See the “To Upload the Public
Certificates” procedure on page 2-42.

To Save the Public Certificate for Microsoft Certificate Services or Active Directory Certificate Services to a File

Step1  Sign in to the server on which you installed Microsoft Certificate Services and issued SSL certificates
for the following servers:

Exchange 2013 (Unity Connection 8.6(2) SU3 and later) or Exchange 2010 client access servers.

Exchange 2007 client access servers, if there are Exchange 2007 mailboxes that you want Unity
Connection to be able to access.

Exchange 2003 servers, if any, on which there are mailboxes that you want Unity Connection to be
able to access.

Active Directory domain controllers that the Unity Connection server might access.
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Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Step 9

Step 10
Step 11
Step 12
Step 13
Step 14

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6
Step 7

Step 8
Step 9
Step 10

On the Windows Start menu, select Programs > Administrative Tools > Certification Authority.

In the left pane of the Certification Authority MMC, right-click the server name, and select Properties.
In the <servername> Properties dialog box, on the General tab, select View Certificate.

In the Certificate dialog box, select the Details tab.

On the Details tab, select Copy to File.

On the Welcome to the Certificate Export Wizard page, select Next.

On the Export File Format page, select Next to accept the default value of DER Encoded Binary
X.509 (.CER).

On the File to Export page, specify the full path of the public certificate, including a location that is
accessible to the Unity Connection server, and a file name.

Select Next.

On the Completing the Certificate Export Wizard page, select Finish.
Select OK three times to close a message box and two dialog boxes.
Close the Certification Authority MMC.

If you issued SSL certificates for all of the servers listed in Step 1 by using the same installation of
Microsoft Certificate Services, you are finished with this procedure. Return to the task list for this
section.

If you issued SSL certificates for all of the servers listed in Step 1 by using different installations of
Microsoft Certificate Services, repeat Step 1 through Step 13 to get one public certificate for each
instance of Microsoft Certificate Services. Then return to the task list for this section.

To Upload the Public Certificates

On the Unity Connection server, sign in to Cisco Unified Operating System Administration.
On the Security menu, select Certificate Management.

Select Upload Certificate.

In the Certificate Name list, select tomcat-trust.

Optional: Enter a description (for example, the name of the certification authority) in the Description
field.

Select Browse.

Browse to the location where you saved the public certificates in .pem format, and select one of the
converted certificates.

Select Upload File.
Repeat Step 3 through Step 8, but select Unity Connection-trust in the Certificate Name list.

If you have public certificates from more than one certification authority, repeat Step 3 through Step 9
for the remaining certificates.
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Testing Unified Messaging Services

Do the following procedure to test one or more unified messaging services.

Step 1

Step 2
Step 3
Step 4
Step 5

To Test Unified Messaging Services for Unity Connection 8.5

In Cisco Unity Connection Administration, expand Unified Messaging, then select Unified Messaging
Services.

On the Search Unified Messaging Services page, select the service that you want to test.

On the Edit Unified Messaging Service page, select Test.

If the test results showed configuration problems, resolve the problems, then repeat the test.

If you configured two or more unified messaging services, repeat Step 1 through Step 4 to test the
remaining services.

Creating Unified Messaging Accounts to Link Cisco Unity
Connection 8.5 and Later Users to Exchange Mailboxes

This section contains the following sections:

How Unified Messaging Accounts and User Accounts are Related, page 2-43
Creating Unified Messaging Accounts, page 2-44

How Unified Messaging Accounts and User Accounts are Related

Unified messaging accounts tie Unity Connection users to unified messaging services. Unified
messaging accounts are separate objects from user accounts:

When you create a user account, Unity Connection does not automatically create a unified
messaging account for that user.

You can create more than one unified messaging account for a user, but a user’s unified messaging
accounts cannot have overlapping features. For example, you cannot create two unified messaging
accounts for the same user that both enable single inbox.

Creating multiple unified messaging accounts for a user is one way to control access to unified
messaging features. For example, if you want all users to have single inbox but only a few users to
have text-to-speech access to Exchange email, you can create two unified messaging services. One
activates single inbox and the other activates TTS. You then create unified messaging accounts for
all users to give them access to single inbox, and you create a second unified messaging account for
the users who you want to have TTS.

When you add a unified messaging account, the associated user account is updated with a reference
to the unified messaging account. The user account does not contain the information on the unified
messaging account.

When you delete a user account, all unified messaging accounts for that user are also deleted.
However, when you delete a unified messaging account, the corresponding user account is not
deleted. The user account is updated only to remove the reference to the unified messaging account.
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Creating Unified Messaging Accounts

Note

Step 1
Step 2

Step 3
Step 4
Step 5

Step 6

Step 7

Do the following procedure to create one or more unified messaging accounts for Unity Connection
users by using Unity Connection Administration. You can also create large numbers of unified
messaging accounts by using the Bulk Administration Tool. For more information, see the “Using the
Cisco Unity Connection 8.x Bulk Administration Tool” appendix in the User Moves, Adds, and Changes
Guide for Cisco Unity Connection Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx.html.

Each unified messaging account is associated with a user, but a unified messaging account is a separate
object in the Unity Connection database. If you delete a unified messaging account, the associated user
account is not deleted.

To Create Unified Messaging Accounts to Link Cisco Unity Connection 8.5 Users to Exchange Mailboxes

In Cisco Unity Connection Administration, expand Users, then select Users.
On the Search Users page, select the alias of a user.

A

Note  If the user alias does not appear in the search results table, set the applicable parameters in the
search fields at the top of the page, and select Search.

On the Edit User Basics page, on the Edit menu, select Unified Messaging Accounts.
On the Unified Messaging Accounts page, select Add New.

On the New Unified Messaging Account page, in the Unified Messaging Service list, select the name
of the service that you want to use for this user. You entered the name when you created the service in
the “To Create a Unified Messaging Service to Access Exchange from Cisco Unity Connection 8.5”
procedure on page 2-38.

The display-only Service Type field should display “Exchange.” If it displays another value, choose a
different unified messaging service.

In the Account Information section, select the applicable option for the Exchange mailbox that you
want to access:

e Use This Email Address—If you want to specify an Exchange mailbox different from the one
associated with the corporate email address, select this option, and enter the email address (the
Active Directory primary SMTP address).

e Use Corporate Email Address—If you want to use the corporate email address, select this option.
(You can edit the value in the Corporate Email Address field on the Edit User Basics page.)

Note  If the unified messaging service that you selected in Step 5 specifies an Exchange server (instead
of automatically searching for Exchange servers), and if users are using TTS to access email in
Exchange 2003, you must also select an option in the Account Information (Used Only for
Exchange 2003 TTS) section and, if applicable, specify a value for the User ID field.

The Account Information (Used Only for Exchange 2003 TTS) section is applicable only when both of
the following are true:

e Users are using TTS to access email in Exchange 2003.
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Step 11

Step 12
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e The unified messaging service that you selected in Step 5 specifies an Exchange server (instead of
automatically searching for Exchange servers)

Select the applicable option:

e Use Unity Connection Alias—This option is useful when the Active Directory domain alias for the
user is the same as the Unity Connection user alias. Unity Connection signs into Exchange as the
user by using the Unity Connection user alias.

e Use User ID Provided Below—Enter the Active Directory domain alias for the user. This option is
useful when the User ID setting is different from the Unity Connection user alias. Unity Connection
signs into Exchange as the user by using the setting in this field.

Verify that the user has an SMTP proxy address that matches the email address that you specified in
Step 6, either by entering a value for the Use This Email Address option or by choosing to use the
corporate email address:

a. On the Edit menu, select SMTP Proxy Address.

b. If the SMTP Proxy Addresses page includes an entry for the email address that you specified in
Step 6, skip to Step 9. Otherwise, continue with Step 8c.

c. Select Add New.
d. Add the email address that you specified in Step 6.
e. Select Save.

The Service Capabilities section displays the options that are enabled in the unified messaging service
that you selected in Step 5. If you want to disable any of the services for this user, uncheck the
corresponding check box.

You can add more than one unified messaging service for a user, but the same service capability cannot
be enabled in more than one unified messaging service for the same user. This also applies to Exchange
calendars and MeetingPlace: you cannot configure a user to access Exchange calendars and
MeetingPlace scheduling and joining.

For information on synchronization behavior if you later disable single inbox in a unified messaging
account, see the “How Disabling and Re-enabling Single Inbox Affects the Synchronization of Unity
Connection and Exchange Mailboxes” section on page 2-10.

Select Save.

To check the configuration for the user, select Test. The Task Execution Results window appears with
the test results.

If any part of the test fails, verify the configuration for Exchange, Active Directory, Cisco Unity
Connection, and the Unity Connection user.

Repeat Step 2 through Step 11 for all remaining users.

Testing Unified Messaging Accounts

Do the following procedure to test one or more of the unified messaging accounts that you created in the
“Creating Unified Messaging Accounts to Link Cisco Unity Connection 8.5 and Later Users to
Exchange Mailboxes” section on page 2-43.
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Step 1
Step 2

Step 3
Step 4
Step 5
Step 6

To Test User Access to Exchange for Individual Cisco Unity Connection 8.5 Users

In Cisco Unity Connection Administration, expand Users, then select Users.

On the Search Users page, select the alias of a user who is configured for one or more unified messaging
features for Exchange.

A

Note If the user alias does not appear in the search results table, set the applicable parameters in the
search fields at the top of the page, and select Search.

On the Edit User Basics page, on the Edit menu, select Unified Messaging Accounts.
Select a unified messaging account for Exchange.
On the Edit Unified Messaging Account page, select Test.

Review the results, resolve problems, if any, and re-run the test until no more problems are found.

Viewing a Summary of the Configuration of Unified Messaging

Accounts

Step 1

Step 2

You can view a summary of the configuration for all of the unified messaging accounts on a Unity
Connection server, including:

e Current status of Unity Connection configuration settings for each unified messaging account,
which indicates whether consistency problems with Unity Connection settings prevent unified
messaging from functioning correctly. When you select the status icon for a unified messaging
account, the Unified Messaging Account page appears, and the status area of the page lists both
problems and possible problems, if any.

You can also test whether a unified messaging account has connectivity with other servers by using
the Test Connectivity button on the Unified Messaging Account page.

e The alias of the user associated with the account. When you select the alias for a unified messaging
account, the Edit Unified Messaging Account page appears, and the status area of the page lists
problems and possible problems, if any.

e The display name of the user associated with the unified messaging account.

e The name of the unified messaging service that is associated with the unified messaging account.
When you select the service name, the Unified Messaging Services page appears with the settings
for the service.

e The current unified messaging settings for each unified messaging account.

To View a Summary of the Configuration of Unified Messaging Accounts for Cisco Unity Connection 8.5

In Cisco Unity Connection Administration, expand Unified Messaging, then select Unified Messaging
Account Status.

To sort by the values in a column in ascending order, select the heading for the column. To sort in
descending order, select the heading again.
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Step3  Todisplay the Unified Messaging Accounts page for an account, select the icon or the value of the Alias
column in the applicable row.

Step4  To display the Unified Messaging Services page for an account, select the value of the UM Services
column in the applicable row.

Testing System Configuration, Including Unified Messaging,
with Exchange and Cisco Unity Connection 8.5 and Later

You can run a Unity Connection system test that includes tests of the unified messaging configuration
and that provides summary data on configuration problems, if any, for example, the number of accounts
assigned to a specified unified messaging service that has configuration problems.

To Check System Configuration, Including Unified Messaging Configuration for Cisco Unity Connection 8.5

Step 1 In Cisco Unity Connection Administration, expand Tools, then select Task Management.
Step2  On the Task Definitions page, select Check System Configuration.

Step3  Select Run Now.

Stepd  Select Refresh to display links to the latest results.

Step5  Review the results, resolve problems, if any, and re-run the Check System Configuration task until no
more problems are found.

Testing Access to Exchange Calendars

If you configured Unity Connection access to Exchange calendars, do the following procedure.

To Test Access to Exchange Calendars for Cisco Unity Connection 8.5

Step1  Sign in to Outlook.
Step 2 On the Go menu, select Calendar.
Step3  On the File menu, select New > Meeting Request.

Step4d  Enter values in the required fields to schedule a new meeting for the current time, and invite a user who
has an account on Cisco Unity Connection.

Step5  Select Send.

Step6  Sign in to the Cisco Unity Connection mailbox of the user that you invited to the Outlook meeting in
Step 4.

Step7  If the user account is configured for speech access, say Play Meetings.

If the user account is not configured for speech access, press 6, and then follow the prompts to list
meetings.

Unity Connection reads the information about the Exchange meeting.
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Resolving SMTP Domain Name Configuration Issues

Step 1

Step 2

Step 3
Step 4

Step 5
Step 6
Step 7

Step 8

Step 9

When a single inbox user receives a voice message, it is synchronized from Cisco Unity Connection to
Microsoft Exchange. The email address of sender/recipient has Unity Connection domain name, for
example, userid @ CUC-hostname. Due to this, email clients like Microsoft Outlook or IBM Lotus Notes
adds the Cisco Unity Connection address as "recent contacts" in the address book. When a user replies
to an email or adds recipient while composing an email, the user can enter/select the Cisco Unity
Connection address, which may lead to NDR. In case you desire when the voice message is synchronized
for single inbox users from Connection to Exchange, the email address of sender/recipient is displayed
as the corporate email address, for example, userid @corp-hostname, you must perform the following
steps:

In Cisco Unity Connection Administration, expand System Settings > SMTP Configuration, then
select Smart Host.

On the Smart Host page, in the Smart Host field, enter the IP address or fully qualified domain name of
the SMTP smart host server. (Enter the fully qualified domain name of the server only if DNS is
configured).

~

Note = Microsoft Exchange server can be used as a smart host.

Click on Save.

Configure corporate email (For example, userid @corp-hostname) address as SMTP Proxy addresses for
connection users. For more information see the “SMTP Proxy Addresses in Cisco Unity Connection 8.x”
section in the Setting Up Features and Functionality That Are Controlled by User Account Settings in
Cisco Unity Connection 8.x chapter of User Moves, Adds, and Changes Guide for Cisco Unity
Connection.

In Cisco Unity Connection Administration, expand System Settings, then select General
Configuration.

On the General Configuration page, in the When a recipient cannot be found list, select Relay
message to smart host so that if the recipient is not found, the message will be sent to the smart host.

Click on Save.

In Cisco Unity Connection Administration, expand Users > Edit > Message Actions. Select the Accept
the message option from the Voicemail drop- down list. Make sure to select the Relay the message
option from the Email, Fax, and receipt drop -down lists.

Setup a recipient policy on Exchange Server such that the Cisco Unity Connection alias resolves to the
corporate email Id.

— For Exchange 2013 (Unity Connection 8.6(2) SU3 and later) or Exchange 2010, see the
following link:

http://technet.microsoft.com/en-us/library/bb232171.aspx

— For Exchange 2007, see the following link:
http://technet.microsoft.com/en-us/library/bb232171(v=exchg.80).aspx.

- For Exchange 2003, see the following link:
http://support.microsoft.com/kb/822447.
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— For Configuring Exchange Email Policies with Unity Connection, please see the following
white paper link:
http://www.cisco.com/en/US/prod/collateral/voicesw/ps6788/ps12506/ps6509/guide_c07-728
014.html.
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CHAPTER3

Configuring Cisco Unity Connection 8.6(2) and
Later and Microsoft Office 365 for Unified
Messaging

Note If Microsoft Office 365 Wave 15 Edition is used, install Cisco Unity Connection 8.6(2) ES 71 and later.

See the following sections:
e About Unified Messaging with Office 365 in Cisco Unity Connection 8.6(2) and Later, page 3-1

e Task List for Configuring Cisco Unity Connection 8.6(2) and Later and Office 365 for Unified
Messaging, page 3-7

e Task list for Creating the Unified Messaging Services Account and Granting Permissions, page 3-10

e Assigning the Application Impersonation Management Role to Unified Messaging Services
Accounts (Office 365 only), page 3-10

e Accessing Office 365 Using Remote Exchange Management PowerShell, page 3-11

¢ Creating a Unified Messaging Service to Access Office 365 from Cisco Unity Connection 8.6(2) and
Later, page 3-12

e Testing Unified Messaging Services for Cisco Unity Connection 8.6(2) and Later, page 3-14
e Testing Unified Messaging Accounts for Cisco Unity Connection 8.6(2) and Later, page 3-14

e Testing System Configuration, Including Unified Messaging, with Office 365 and Cisco Unity
Connection 8.6(2) and Later, page 3-15

e Testing Access to Office 365 Calendars for Cisco Unity Connection 8.6(2) and Later, page 3-15

About Unified Messaging with Office 365 in Cisco Unity
Connection 8.6(2) and Later

See the following sections:
e Accessing Office 365 Email by Using Text to Speech, page 3-2
e Accessing Office 365 Calendars and Contacts, page 3-2
¢ Synchronizing Voice Messages in Connection and Office 365 Mailboxes (Single Inbox), page 3-2
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Accessing Office 365 Email by Using Text to Speech

When Cisco Unity Connection is configured to allow access to Office 365 email by using text to speech,
users have the option to hear their emails read to them when they sign in to Cisco Unity Connection by
phone.

Accessing Office 365 Calendars and Contacts

When Cisco Unity Connection is configured to access Office 365 calendars and contacts, Unity
Connection users can do the following by phone:

Hear a list of upcoming meetings (Outlook meetings only).
Hear a list of the participants for a meeting.

Send a message to the meeting organizer.

Send a message to the meeting participants.

Accept or decline meeting invitations (Outlook meetings only).

Cancel a meeting (meeting organizers only).

In addition, Unity Connection enables users to import Office 365 contacts by using the Unity Connection
Messaging Assistant web tool. The contact information can then be used in rules that users create in the
Cisco Unity Connection Personal Call Transfer Rules web tool and when users place outgoing calls by
using voice commands.

Synchronizing Voice Messages in Connection and Office 365 Mailboxes

(Single Inbox)

This section describes how synchronizing voice messages in Connection and Office 365 mailboxes
works. See the following sections:

Where Voice Messages are Stored When Single Inbox is Configured, page 3-3

How Single Inbox Works with ViewMail for Outlook, page 3-3

How Single Inbox Works without ViewMail for Outlook or with Other Email Clients, page 3-3
Accessing Secure Voice Messages in the Exchange Mailbox, page 3-3

How Synchronization Works with Outlook Folders, page 3-4

Where Deleted Messages Go, page 3-4

Types of Unity Connection Messages that are Not Synchronized with Office 365, page 3-5
Replication of Status Changes, page 3-5

How Disabling and Re-enabling Single Inbox Affects the Synchronization of Unity Connection and
Office 365 Mailboxes, page 3-5

How Read/Heard Receipts, Delivery Receipts, and Non-delivery Receipts are Synchronized,
page 3-6
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Where Voice Messages are Stored When Single Inbox is Configured

All Unity Connection voice messages, including those sent from Cisco Unity Connection ViewMail for
Microsoft Outlook, are first stored in Unity Connection and are immediately replicated to the Office 365
mailbox for the recipient.

How Single Inbox Works with ViewMail for Qutlook

If you want users to use Outlook to send new Unity Connection voice messages, or to reply to or forward
voice messages, and if you want the messages to be synchronized with Unity Connection:

e If you have not already done so, in Unity Connection Administration, add SMTP proxy addresses
for the Unity Connection users that are configured for single inbox. The SMTP proxy address for a
user must match the Office 365 email address that is specified in the unified messaging account in
which single inbox is enabled.

e Install ViewMail for Outlook on user workstations. Without ViewMail for Outlook installed, voice
messages are sent by Outlook as emails with .wav file attachments, and are treated as emails by
Unity Connection.

¢ On each user workstation, associate an email account with a Unity Connection server.

Voice messages appear in the Outlook Inbox folder of the user, alongside other messages that are stored
in Office 365; the voice messages also appear in the Unity Connection mailbox of the user.

When single inbox is configured, Unity Connection adds a Voice Outbox folder to the Outlook mailbox.
Unity Connection voice messages sent from Outlook do not appear in the Sent Items folder.

Private messages cannot be forwarded.

How Single Inbox Works without ViewMail for Qutlook or with Other Email Clients

If you use another email client to access Unity Connection voice messages in Office 365, or if you do
not install ViewMail for Outlook:

e The email client treats Unity Connection voice messages like emails with .wav file attachments.

e When a user replies to or forwards a Unity Connection voice message, the reply or forward also is
treated like an email, even if the user attaches a .wav file. Message routing is handled by Office 365,
not by Unity Connection, so the message is never sent to the Unity Connection mailbox for the
recipient.

e Users cannot listen to secure voice messages.

e It may be possible to forward private voice messages. (When users use ViewMail for Outlook,
ViewMail for Outlook prevents private messages from being forwarded.)

Accessing Secure Voice Messages in the Exchange Mailbox

To play secure Unity Connection voice messages in the Exchange mailbox, users must use Microsoft
Outlook and Cisco Unity Connection ViewMail for Microsoft Outlook. Without ViewMail for Outlook
installed, users accessing secure voice messages see only text in the body of a decoy message; the text
briefly explains secure messages.
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How Synchronization Works with Qutlook Folders

Unity Connection synchronizes voice messages in the following Outlook folders with the Unity
Connection Inbox folder for the user, so the messages are still visible in the Unity Connection Inbox
folder:

¢ Subfolders under the Outlook Inbox folder
e Subfolders under the Outlook Deleted Items folder
e The Outlook Junk Email folder
Messages in the Outlook Deleted Items folder appear in the Unity Connection deleted items folder.

If the user moves voice messages (except secure voice messages) into Outlook folders that are not under
the Inbox folder, the messages are moved to the deleted items folder in Unity Connection. The messages
can still be played by using ViewMail for Outlook because a copy still exists in the Outlook folder. If
the user moves the messages back into the Outlook Inbox folder or into an Outlook folder that is
synchronized with the Unity Connection Inbox folder, and:

e If the message is still in the deleted items folder in Unity Connection, the message is synchronized
back into the Unity Connection Inbox for that user.

e If the message is not still in the deleted items folder in Unity Connection, the message is still
playable in Outlook, but it is not resynchronized into Unity Connection.

Secure voice messages behave differently. When Unity Connection replicates a secure voice message to
Office 365, it replicates only a decoy message that briefly explains secure messages; the only copy of

the voice message remains on the Unity Connection server. When a user plays a secure message by using
ViewMail for Outlook, ViewMail retrieves the message from the Unity Connection server and plays it

without ever storing the message in Office 365 or on the computer of the user.

If the user moves a secure message to an Outlook folder that is not synchronized with the Unity
Connection Inbox folder, the only copy of the voice message is moved to the deleted items folder in
Unity Connection, and the message can no longer be played in Outlook. If the user moves the message
back into the Outlook Inbox folder or into an Outlook folder that is synchronized with the Unity
Connection Inbox folder, and:

e If the message is still in the deleted items folder in Unity Connection, the message is synchronized
back into the Unity Connection Inbox for that user, and the message becomes playable again in
Outlook.

e If the message is not still in the deleted items folder in Unity Connection, the message is not
resynchronized into Unity Connection and can no longer be played in Outlook.

Where Deleted Messages Go

By default, when a user deletes a voice message in Unity Connection, the message is sent to the Unity
Connection deleted items folder and synchronized with the Outlook Deleted Items folder. When the
message is deleted from the Unity Connection deleted items folder (the user can do this manually, or you
can configure message aging to do it automatically), it is also deleted from the Outlook Deleted Items
folder.

If you are adding the single-inbox feature to an existing system, and if you have configured Unity
Connection to permanently delete messages without saving them in the deleted items folder, messages
that users delete by using the Web Inbox or by using the Unity Connection phone interface are still
permanently deleted. However, messages that users delete by using Outlook are only moved to the
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Deleted Items folder in Outlook, not permanently deleted. When Unity Connection synchronizes with
Office 365, the message is moved to the Unity Connection deleted items folder; it is not permanently
deleted. We recommend that you do one or both of the following:

¢ Configure message aging to permanently delete messages in the Unity Connection deleted items
folder.

¢ Configure message quotas, so that Unity Connection prompts users to delete messages when their
mailboxes approach a specified size.

When a user deletes a voice message from any Outlook folder, including the Outlook Inbox folder, the
Deleted Items folder, or any subfolder, the message is moved to the deleted items folder in Unity
Connection. No operation in Outlook will cause a message to be permanently deleted in Unity
Connection.

Types of Unity Connection Messages that are Not Synchronized with Office 365

The following types of messages are not synchronized:
e Sent messages
¢ Draft messages
e Messages configured for future delivery but not yet delivered
e Broadcast messages

e Unaccepted dispatch messages. When a dispatch message has been accepted by a recipient, it
becomes a normal message and is synchronized with Office 365 for the user who accepted it and
deleted for all other recipients. Until someone on the distribution list accepts a dispatch message,
the message waiting indicator for everyone on the distribution list will remain on, even when users
have no other unread messages.

Replication of Status Changes

Status changes (for example, from unread to read), changes to the subject line, and changes to the
priority are replicated from Unity Connection to Exchange and vice versa, as applicable.

How Disabling and Re-enabling Single Inbox Affects the Synchronization of Unity Connection and
Office 365 Mailboxes

When you configure unified messaging, you create one or more unified messaging services that define,
among other things, which unified messaging features are enabled. You also create one or more unified
messaging accounts for each user to associate the user with unified messaging services. You can disable
single inbox in three ways:

¢ Entirely disable a unified messaging service in which single inbox is enabled. This disables all
enabled unified messaging features (including single inbox) for all users that are associated with the
service.

¢ Disable only the single inbox feature for a unified messaging service, which disables only the single
inbox feature for all users that are associated with that service.

e Disable single inbox for a unified messaging account, which disables single inbox only for the
associated user.

If you disable and later re-enable single inbox by using any of these methods, Connection resynchronizes
the Connection and Office 365 mailboxes for the affected users. Note the following:

Unified Messaging Guide for Cisco Unity Connection Release 8.x
| "=



Chapter 3 Configuring Cisco Unity Connection 8.6(2) and Later and Microsoft Office 365 for Unified Messaging |
I About Unified Messaging with Office 365 in Cisco Unity Connection 8.6(2) and Later

e [If users delete messages in Office 365 but do not delete the corresponding messages in Connection
while single inbox is disabled, the messages will be resynchronized into the Office 365 mailbox
when single inbox is re-enabled.

e If messages are hard deleted from Office 365 (deleted from the Deleted Items folder) before single
inbox is disabled, the corresponding messages that are still in the deleted items folder in Unity
Connection when single inbox is re-enabled will be resynchronized into the Office 365 Deleted
Items folder.

e If users delete messages in Connection but do not delete the corresponding messages in Office 365
while single inbox is disabled, the messages remain in Office 365 when single inbox is re-enabled.
Users must delete the messages from Office 365 manually.

e If users change the status of messages in Office 365 (for example, from unread to read) while single
inbox is disabled, the status of Office 365 messages will be changed to the current status of the
corresponding Connection messages when single inbox is re-enabled.

¢  When you re-enable single inbox, depending on the number of users associated with the service and
the size of their Connection and Office 365 mailboxes, resynchronization for existing messages may
affect synchronization performance for new messages.

How Read/Heard Receipts, Delivery Receipts, and Non-delivery Receipts are Synchronized

Unity Connection can send heard/read receipts, delivery receipts, and non-delivery receipts to Unity
Connection users who send voice messages. If the sender of a voice message is configured for single
inbox, the applicable receipt is sent to the Unity Connection mailbox for the sender. The receipt is then
synchronized into the Office 365 mailbox for the sender.

Note the following.

® Read/heard receipts: When sending a voice message, a sender can request a read/heard receipt. If
you do not want Unity Connection to respond to requests for read receipts, in Unity
Connection Administration, uncheck the Respond to Requests for Read Receipts check box, which
appears on theUsers > Edit > Mailbox page and on the Templates > User Templates > Edit >
Mailbox page.

e Delivery receipts: A sender can request a delivery receipt only when sending a voice message from
ViewMail for Outlook. You cannot prevent Unity Connection from responding to a request for a
delivery receipt.

® Non-delivery receipts (NDR): A sender receives an NDR when a voice message cannot be delivered.
If you do not want Unity Connection to send an NDR when a message cannot be delivered, in Unity
Connection Administration, uncheck the Send Non-Delivery Receipts for Message Failed Delivery
check box, which appears on theUsers > Edit User Basics page and on the Templates > User
Templates > Edit User Template Basics page.

Note the following about NDRs:

— When the sender accesses Unity Connection by using the TUI, the NDR includes the original
voice message, which allows the sender to resend the message at a later time or to a different
recipient.

— When the sender accesses Unity Connection by using Web Inbox, the NDR includes the original
voice message, but the sender cannot resend it.

— When the sender uses ViewMail for Outlook to access Unity Connection voice messages that
have been synchronized into Office 365, the NDR is a receipt that contains only an error code,
not the original voice message, so the sender cannot resend the voice message.
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— When the sender is an outside caller, NDRs are sent to Unity Connection users on the
Undeliverable Messages distribution list. Verify that the Undeliverable Messages distribution
list includes one or more users who regularly monitors and reroutes undelivered messages.

Task List for Configuring Cisco Unity Connection 8.6(2) and Later
and Office 365 for Unified Messaging

To configure one or more unified messaging features, complete the following tasks in the order
presented.

1. Review the “Requirements for Using Unified Messaging Features (Connection 8.5 and Later Only)”
section in the System Requirements for Cisco Unity Connection Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucsysreqs.html

2. Cisco Unified Communications Manager Business Edition only: Confirm that Unity Connection is
licensed for single inbox. See the “Assigning the Application Impersonation Management Role to
Unified Messaging Services Accounts (Office 365 only)” section on page 3-10

3. If Unity Connection is integrated with an LDAP directory: Review the current LDAP directory
configurations to confirm that the Cisco Unified Communications Manager Mail ID field is
synchronized with the LDAP mail field. During the integration process, this causes values in the
LDAP mail field to appear in the Corporate Email Address field in Unity Connection.

Unified messaging requires that you enter the Office 365 email address for each Unity Connection
user. On the Unified Messaging Account page, each user can be configured to use either of the
following values:

— The Corporate Email Address specified on the User Basics page
— The email address specified on the Unified Messaging Account page

Email address field on the Unified Messaging Account page can be populated by using Unity
Connection Administration or the Bulk Administration Tool.

S

Note  Unity Connection supports on-premise LDAP directory integration only.

4. Ifyou are using single inbox and you want users to be able to use ViewMail for Outlook to send new
voice messages, or to forward or reply to voice messages: Install Cisco Unity Connection ViewMail
for Microsoft Outlook on user workstations. For more information on installing ViewMail for
Outlook, see the Release Notes for Cisco Unity Connection ViewMail for Microsoft Outlook Release
8.5(x) at http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.

5. Synchronization threads configuration should be done based on latency between Unity Connection
and Office 365 server. For more information, refer to "Latency"” section of the design guide at

http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/design/guide/8xcucdg032.html.

6. Decide whether you want Connection to be able to search for and communicate with different Office
365 server, or you want Connection to communicate with a specific Office 365 server in case the
hostname or the IP Address of the specific Office 365 server is known. Auto Discovery is the
recommended option.

If Connection is not already configured to use DNS, use the following CLI commands to configure
DNS:
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- set network dns
- set network dns options

We recommend that you configure Unity Connection to use the same DNS environment in which the
Active Directory environment is publishing its records.

For more information on the CLI commands, see the applicable Command Line Interface Reference
Guide for Cisco Unified Communications Solutions at
http://www.cisco.com/en/US/products/ps6509/prod_maintenance_guides_list.html

7. Create an Active Directory account to be used for Unity Connection unified messaging services, and
grant the account the applicable permissions. See the “Creating the Unified Messaging Services
Account on Office 365 and Granting Permissions” section on page 3-10.

8. Ifyouare using single inbox and users do not already have added SMTP proxy addresses: Add proxy
addresses to Connection user accounts. For more information, see the "SMTP Proxy Addresses in
Cisco Unity Connection 8.x" section in the "Setting Up Features and Functionality That Are
Controlled by User Account Settings in Cisco Unity Connection 8.x" chapter of the User Moves,
Adds, and Changes Guide for Cisco Unity Connection, available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx.htm
L.

9. Update class of service settings as required:

- Enable single inbox in one or more classes of service. For more information, see the “Single
Inbox in Cisco Unity Connection 8.5 and Later” section in the “Setting Up Features and
Functionality That Are Controlled by Class of Service in Cisco Unity Connection 8.x” chapter
of the User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 8.x, available
at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user_mac/guide/8xcucmacx
.html.

Note that all users who are configured to use single inbox must be in a class of service in which
single inbox is enabled.

Cisco Unified Communications Manager Business Edition only: Unity Connection counts all
users in a class of service in which single inbox is enabled as single inbox users even if they are
not configured to use single inbox. For example, if a Unity Connection server is licensed for
200 single-inbox users, and if you have three classes of service in which single inbox is enabled,
the total number of users assigned to those three classes of service cannot exceed 200 users. This
is true even if you only configure 50 users to use single inbox.

— Enable text-to-speech access to Exchange voice messages on one or more classes of service:
check the Allow Access to Advanced Features check box on the applicable class of service page,
and then check the Allow Access to Exchange Email by Using Text to Speech (TTS) check box.

10. If classes of service for single-inbox users have Delete Messages Without Saving to Deleted Items
Folder enabled: We recommend that you configure message aging and/or message quotas.
Otherwise, messages deleted from Outlook may never be permanently deleted from Unity
Connection. For more information, see the “Synchronizing Voice Messages in Connection and
Office 365 Mailboxes (Single Inbox)” section on page 3-2.

For more information on configuring message aging and message quotas for Unity Connection, see
the “Controlling the Size of Mailboxes in Cisco Unity Connection 8.x” chapter in the System
Administration Guide for Cisco Unity Connection Release 8.x, available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx
html.
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1.
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Configure one or more Unity Connection unified messaging services. See the “Creating a Unified
Messaging Service to Access Office 365 from Cisco Unity Connection 8.6(2) and Later” section on
page 3-12.

Selected configurations: For the following configuration, upload SSL certificates on the Unity
Connection server to encrypt communication between Unity Connection and Office 365 and
between Unity Connection and Active Directory:

If you configured Connection to search for and communicate with different Exchange servers, to use
LDAPS to communicate with domain controllers, and to validate certificates for domain controllers
in Task 10.

A

Caution  When you allow Unity Connection to search for and communicate with Office 365 servers,

13.

14.

15.

Unity Connection communicates with Active Directory servers using Basic authentication. By
default, the user name and password of the unified messaging services account and all other
communication between the Unity Connection and Active Directory servers is sent in clear
text. If you want this data to be encrypted, in Task 11. you must configure unified messaging
services to communicate with Active Directory domain controllers by using the secure LDAP
(LDAPS) protocol.

For more information, see the Uploading CA Public Certificates for Exchange and Active Directory
Servers, page 2-41.

Test the unified messaging configuration. See the following sections:
— Testing Unified Messaging Services for Cisco Unity Connection 8.6(2) and Later, page 3-14
— Testing Unified Messaging Accounts for Cisco Unity Connection 8.6(2) and Later, page 3-14

— Testing System Configuration, Including Unified Messaging, with Office 365 and Cisco Unity
Connection 8.6(2) and Later, page 3-15

— Testing Access to Office 365 Calendars for Cisco Unity Connection 8.6(2) and Later, page 3-15

If Unity Connection voice messages are automatically being moved to the Outlook Junk Items folder:
Change the Outlook configuration to add the sender of the voice message or the sender’s domain to
the safe sender’s list. For more information, see Outlook Help.

To teach users how to use the Unity Connection calendar, refer them to the following:

— For listing, joining, and scheduling meetings, see the “Cisco Unity Connection Phone Menus
and Voice Commands” chapter of the User Guide for the Cisco Unity Connection Phone
Interface (Release 8.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/phone/b_8xcucu
gphone.html.

— For importing Exchange contacts, see the “Managing Your Personal Contacts” chapter of the
User Guide for the Cisco Unity Connection Messaging Assistant Web Tool (Release 8.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/assistant/b_8xcu
cugasst.html.

— For using personal call transfer rules, see the User Guide for the Cisco Unity Connection
Personal Call Transfer Rules Web Tool (Release 8.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/pctr/b_8xcucugp
ctr.html.

Office 365 servers, which Connection accesses have authentication mode set to Basic and web-based

protocol set to HTTPS.
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Creating the Unified Messaging Services Account on Office 365
and Granting Permissions

Cisco Unity Connection accesses Office 365 mailboxes by using a domain service account called the
unified messaging services account. After you create the account, you grant it the rights necessary for
Unity Connection to perform operations on behalf of the user.

See the following section:

Task list for Creating the Unified Messaging Services Account and Granting Permissions, page 3-10

Task list for Creating the Unified Messaging Services Account
and Granting Permissions

1. Create one or more service accounts on the Office 365 servers with which you want Connection to
communicate. Note the following:

— Give the account a name that identifies it as the unified messaging services account for
Connection.

— Do not add the account to any administrator group.
— Do not disable the account, or Connection cannot use it to access Office 365 mailboxes.

— Specify a password that satisfies the password-security requirements of your company. The
password is encrypted with AES 128-bit encryption and stored in the Connection database. The
key that is used to encrypt the password is accessible only with root access, and root access is
available only with assistance from Cisco TAC.

— When you are configuring unified messaging for a Connection cluster, Connection
automatically uses the same unified messaging services account for both Connection servers.

— When you are configuring unified messaging for intersite networking or for intrasite
networking, you can use the same unified messaging services account for more than one
Connection server. However, this is not a requirement and does not affect functionality or
performance.

2. For Assigning the Impersonation Rights to Service Accounts see the following Section,Release 8.x
at Assigning the Application Impersonation Management Role to Unified Messaging Services
Accounts (Office 365 only), page 3-10

Assigning the Application Impersonation Management Role to Unified
Messaging Services Accounts (Office 365 only)

To Assign the Application Impersonation Management Role to Unified Messaging Services Accounts (Office 365
Only)

Step 1 To configure impersonation in Office 365, you must run a Windows PowerShell script. For details see
the, “Accessing Office 365 Using Remote Exchange Management PowerShell” section on page 3-11"
section.

Unified Messaging Guide for Cisco Unity Connection Release 8.x
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Step 2

Note

Step 3

A

Accessing Office 365 Using Remote Exchange Management PowerShell

You must have the permission to run the New-ManagementRoleAssignment cmdlet. By default the
administrators have this permission.

Use "New-ManagementRoleAssignment" Exchange Management Shell cmdlet to grant the service
account permission to impersonate all the users in the organization.

new-ManagementRoleAssignment -Name:RoleName -Role:ApplicationImpersonation
-User:Account

where:

—Name parameter specifies the name of the new role assignment, for example,
ConnectionUMServicesAcct. The name that you enter for RoleName appears when you run
get-ManagementRole Assignment.

-Role parameter indicates that the Applicationlmpersonation role is assigned to the user specified by the
User parameter.

—User is the name of the unified messaging services account in alias@domain format.
For example:

New-ManagementRoleAssignment —Name ''ConnectionUMServicesAcct' —Role
""Applicationlmpersonation' —User serviceaccount@example.onmicrosoft.com

This operation may not be allowed for the organization with the disabled customizations. In order to
enable this operation, you need to execute the Enable-OrganizationCustomization task first, that is
“Enable-OrganizationCustomization”.

If you created more than one unified messaging services account, repeat Step 2 for the remaining
accounts. Specify a different value for RoleName for each unified messaging services account.

Caution

If you have activated the Active Directory Synchronization feature and migrating from local Exchange
server to Office 365, then the further user management is done through the on-premises Active Directory
Services and it gets synchronized with Office 365 automatically. You must make sure the Application
Impersonation Management role is given to your Office 365 server.

Accessing Office 365 Using Remote Exchange Management
PowerShell

Step 1
Step 2

To Access Office 365 Using Remote Exchange Management Power Shell

Run Windows PowerShell as administrator

On a Windows PowerShell endpoint, run the following command and enter the Office-365 administrator
account credentials for authentication in the popup window.

$LiveCred = Get-Credential
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Step 3

Step 4

To establish a remote Windows PowerShell session with Office 365, use the New-PSSession Windows
PowerShell cmdlet to connect with the generic remote Windows PowerShell endpoint at
http://ps.outlook.com/powershell. Run the following command to create Remote Exchange Shell
Session.

$Session = New-PSSession -ConfigurationName Microsoft.Exchange -ConnectionUri
https://ps.outlook.com/powershell/ -Credential $LiveCred -Authentication Basic
-AllowRedirection

Run the following command to Import all Remote Exchange Shell Commands to the local client side
session.

Import-PSSession $Session

Creating a Unified Messaging Service to Access Office 365 from Cisco Unity
Connection 8.6(2) and Later

Step 1

Step 2
Step 3

Step 4

Note

Step 5

Step 6

Step 7

Step 8

To Create a Unified Messaging Service to Access Office 365 from Cisco Unity Connection 8.6(2) and Later

In Cisco Unity Connection Administration, expand Unified Messaging, then select Unified Messaging
Services.

On the Search Unified Messaging Services page, select Add New.

Decide which options to select for the Message Action for Email and Message Action for Fax lists at the
bottom of the page. (For field information, on the Help menu, select This Page.)

If you want to select Relay the Message or Accept and Relay the Message for either list, you must first
configure an SMTP Smart Host on the System Settings > SMTP Configuration > Smart Host page.
Connection Administration will not let you save a new unified messaging configuration with those
settings when no SMTP Smart Host is configured. For SMTP smart host server, Unity Connection will
communicate with on -premise SMTP relay servers only.

On the New Unified Messaging Service page, in the Type list, select Office 365.

You can configure up to 1800 users with a single Office 365 Unified Messaging Service. For creating
more than 1800 users with Office 365, you need to create more Unified Messaging services.

Check the Enabled check box to enable the service.

For information on synchronization behavior if you later disable a unified messaging service for which
single inbox is enabled, see the “How Disabling and Re-enabling Single Inbox Affects the
Synchronization of Unity Connection and Office 365 Mailboxes” section on page 3-5

In the Display Name field, enter a descriptive name.

If you are creating more than one unified messaging service for Office 365, note that this is the name
that will appear on the Users > Unified Messaging Accounts page when you configure users for unified
messaging. Enter a display name that will simplify choosing the correct unified messaging service for
each user.

Beginning with Unity Connection 8.6(2) ES 36 and later, if you want Unity Connection to validate the
SSL certificate from the Exchange server, check the Validate Certificates for Exchange Servers check
box.

In the Proxy Server field, enter the IP Address and port in the Adress:Port or Hostname:Port format.

Unified Messaging Guide for Cisco Unity Connection Release 8.x
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Accessing Office 365 Using Remote Exchange Management PowerShell

Note  Proxy Server is an optional field that allows you to route the traffic using a Proxy server when the Office
365 network is not accessible from Unity Connection.

Step9  If you want Connection to automatically find Hosted Exchange client access servers, do the following:

a. Select Search for Hosted Exchange Servers.

Note It is mandatory to use Search for Hosted Exchange Servers option with Office 365.

b. Enter DNS Domain Name used for the Office 365 users.

¢ In a hybrid environment where you route mails between an on-premise Exchange organization
and Office 365, specify the special onmicrosoft.com domain name (such as
mycompany.mail.onmicrosoft.com) provided by Microsoft.

e If you are only using Office 365, try your domain name from your email addresses.

c. If you have Hosted Exchange servers in more than one Active Directory site, you can improve
performance if you specify the site that contains the domain controllers that you want Connection
to use to find Exchange servers. In the Active Directory Site Name field, enter the name of the site.

d. In the Protocol Used to Communicate with Domain Controllers list, select whether Connection
should use LDAP or secure LDAP (LDAPS) when communicating with Active Directory to find
Hosted Exchange servers.

A

Caution  Caution: When you select Search for Hosted Exchange Servers, Connection communicates with Active
Directory servers using Basic authentication. As a result, the username and password of the unified
messaging services account and all other communication between the Connection and Active Directory
servers is in clear text. If you want this data to be encrypted, you must select Secure LDAP (LDAPS) in
the Protocol Used to Communicate with Domain Controllers list and upload certificates from the
certification authority that issued the SSL certificates for Active Directory servers to both tomcat-trust
and Unity Connection-trust locations.

e. If you want Connection to validate the SSL certificate from Active Directory domain controllers,
check the Validate Certificates for Active Directory Domain Controllers check box.

Self-signed certificates cannot be validated. If you selected LDAPS from the Protocol Used to
Communicate with Domain Controllers list, and if you are using self-signed certificates, do not
check the Validate Certificates for Active Directory Domain Controllers check box. If you do
check the check box, Connection will not be able to access domain controllers to search for Hosted
Exchange servers.

Step10 In the Username and Password fields, enter the Active Directory username and password for the
Domain Service account provided by Microsoft Office 365.

The username must be in User Principal Name(username @domain.com) format.

Step11  Under Service Capabilities, select the features that you want this unified messaging service to allow.
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S

Note  When you configure unified messaging for Connection users, you can disable for an individual user any
feature that you enable here. However, you cannot enable for an individual user any feature that you disable here.

For information on synchronization behavior if you later disable a unified messaging service for
which single inbox is enabled, see the “How Disabling and Re-enabling Single Inbox Affects the
Synchronization of Unity Connection and Office 365 Mailboxes” section on page 3-5

Step12 Under Synchronize Connection and Office 365 Mailboxes (Single Inbox), choose message actions for
email and for fax. (For field information, on the

Testing Unified Messaging Services for Cisco Unity
Connection 8.6(2) and Later

Do the following procedure to test one or more unified messaging services.

To Test Unified Messaging Services for Connection 8.5

Step1  In Cisco Unity Connection Administration, expand Unified Messaging, then select Unified Messaging
Services.

Step2  On the Search Unified Messaging Services page, select the service that you want to test.
Step3  On the Edit Unified Messaging Service page, select Test.
Step4  If the test results showed configuration problems, resolve the problems, then repeat the test.

Step5 If you configured two or more unified messaging services, repeat Step 1 through Step 4 to test the
remaining services.

Testing Unified Messaging Accounts for Cisco Unity
Connection 8.6(2) and Later

Do the following procedure to test one or more of the unified messaging accounts that you created in the
Creating the Unified Messaging Services Account on Office 365 and Granting Permissions, page 3-10

To Test User Access to Office 365 for Individual Cisco Unity Connection 8.6(2) Users

Step 1 In Cisco Unity Connection Administration, expand Users, then select Users.

Step2  On the Search Users page, select the alias of a user who is configured for one or more unified messaging
features for Office 365.

~

Note  If the user alias does not appear in the search results table, set the applicable parameters in the
search fields at the top of the page, and select Search.
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Step 3
Step 4
Step 5
Step 6

Testing System Configuration, Including Unified Messaging, with Office 365 and Cisco Unity Connection 8.6(2) and 1l

On the Edit User Basics page, on the Edit menu, select Unified Messaging Accounts.
Select a unified messaging account for Exchange.
On the Edit Unified Messaging Account page, select Test.

Review the results, resolve problems, if any, and re-run the test until no more problems are found.

Testing System Configuration, Including Unified Messaging,
with Office 365 and Cisco Unity Connection 8.6(2) and Later

Step 1
Step 2
Step 3
Step 4
Step 5

You can run a Unity Connection system test that includes tests of the unified messaging configuration
and that provides summary data on configuration problems, if any, for example, the number of accounts
assigned to a specified unified messaging service that has configuration problems.

To Check System Configuration, Including Unified Messaging Configuration for Cisco Unity Connection 8.6(2)

In Cisco Unity Connection Administration, expand Tools, then select Task Management.
On the Task Definitions page, select Check System Configuration.

Select Run Now.

Select Refresh to display links to the latest results.

Review the results, resolve problems, if any, and re-run the Check System Configuration task until no
more problems are found.

Testing Access to Office 365 Calendars for Cisco Unity
Connection 8.6(2) and Later

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

Step 7

If you configured Unity Connection access to Office 365 calendars, do the following procedure.

To Test Access to Office 365 Calendars for Cisco Unity Connection 8.6(2)

Sign in to Outlook.
On the Go menu, select Calendar.
On the File menu, select New > Meeting Request.

Enter values in the required fields to schedule a new meeting for the current time, and invite a user who
has an account on Cisco Unity Connection.

Select Send.

Sign in to the Cisco Unity Connection mailbox of the user that you invited to the Outlook meeting in
Step 4.

If the user account is configured for speech access, say Play Meetings.
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If the user account is not configured for speech access, press 6, and then follow the prompts to list
meetings.

Unity Connection reads the information about the Exchange meeting.
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CHAPTER I

Moving Microsoft Exchange Mailboxes for Unity
Connection 8.5 and Later Users Configured for
Unified Messaging

See the following sections:

e Determining When You Must Update Cisco Unity Connection User Settings Manually After You
Move Exchange Mailboxes, page 4-1

e Moving Exchange Mailboxes to a New Exchange Server for Connection 8.5 and Later, page 4-2

e Replacing Connection 8.5 and Later Unified Messaging Accounts After You Move Exchange
Mailboxes, page 4-2

Determining When You Must Update Cisco Unity Connection
User Settings Manually After You Move Exchange Mailboxes

If you create one or more unified messaging services for Exchange, as described in the “Configuring
Cisco Unity Connection 8.5 and Later and Microsoft Exchange for Unified Messaging” chapter, one of
the settings identifies the Exchange servers that Unity Connection communicates with:

e If you choose to allow Unity Connection to search for Exchange servers, Unity Connection can
automatically detect when you move mailboxes from one version of Exchange to another and can
automatically update Unity Connection user settings.

e If you choose a specific Exchange server, Unity Connection can sometimes detect when you move
mailboxes from one Exchange server to another, and can automatically update hidden Unity
Connection user settings. When Unity Connection cannot detect mailbox moves, you must manually
replace the unified messaging account that accesses the old Exchange server with a unified
messaging account that accesses the new server. Table 4-1 identifies when Unity Connection can and
cannot automatically detect mailbox moves between Exchange servers.

If Unity Connection cannot automatically detect mailbox moves, do the procedure in the “Replacing
Connection 8.5 and Later Unified Messaging Accounts After You Move Exchange Mailboxes” section
on page 4-2.
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Table 4-1 When Unity Connection Can Detect Mailbox Moves Between Exchange server (continued)

Unity Connection can automatically detect mailbox moves between the following Exchange

versions

2003 and |2003and |2003and (2007 and 2007 and (2010and 2007 and |2010and 2013 and
If you choose a specific 2003 2007 2010 2007 2010 2010 2013 2013 2013
Exchange 2003 server No No No No No No No No No
Exchange 2007 server No No No Yes No No No No No
Exchange 2010 server No No No Yes Yes Yes No No No
Exchange 2013 server No No No Yes Yes Yes Yes Yes Yes

Moving Exchange Mailboxes to a New Exchange Server for
Unity Connection 8.5 and Later

If you add an Exchange server to the Exchange organization, you want to move Exchange mailboxes to
the new server, and the Exchange mailboxes are associated with Unity Connection users who are
configured for single inbox, you must grant the permissions that Unity Connection requires before you
move the mailboxes. Otherwise, Unity Connection users will not be able to access their voice messages
in the new location. This is true regardless of whether you allow Unity Connection to search for
Exchange servers or you configure Unity Connection to communicate with a specific Exchange server.

For information on granting the necessary permissions, see the “Creating the Unified Messaging
Services Account in Active Directory and Granting Permissions” section on page 2-28. Note that
creating a new unified messaging services account for the new Exchange server is not necessary; you
can also grant an existing unified messaging services account the permissions required to access the new
Exchange server.

Replacing Unity Connection 8.5 and Later Unified Messaging
Accounts After You Move Exchange Mailboxes

When Unity Connection cannot detect Exchange mailbox moves and, therefore, cannot automatically
update the location of the Exchange mailbox for a Unity Connection user, you must manually create a
new unified messaging account that accesses the new mailbox location and delete the unified messaging
account that accessed the old mailbox location.

A

Caution  Between the time that you move Exchange mailboxes and the time that you update Unity Connection
settings for the affected users, Unity Connection will not synchronize voice messages with the
corresponding Exchange mailboxes.

To Replace Unity Connection 8.5 Unified Messaging Accounts After You Move Exchange Mailboxes

Step 1 Review the “Determining When You Must Update Cisco Unity Connection User Settings Manually
After You Move Exchange Mailboxes” section on page 4-1 to determine whether Unity Connection can
automatically detect mailbox moves for your Exchange configuration and Unity Connection settings:

e If Unity Connection can detect mailbox moves, skip the rest of this procedure.
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Step 2

Step 3

Step 4

Step 5

Replacing Unity Connection 8.5 and Later Unified Messaging Accounts After You Move Exchange Mailboxes ||

e If Unity Connection cannot detect mailbox moves, continue with Step 2.

If you moved the Exchange mailbox to an Exchange server for which there is currently no Unity
Connection unified messaging service, create the service. For more information, see the “Creating a

Unified Messaging Service to Access Exchange from Cisco Unity Connection 8.5 and Later” section on
page 2-38.

Create a new unified messaging account for the user, and choose a unified messaging service that
accesses the Exchange server to which the mailbox was moved. For more information, see the “Creating

Unified Messaging Accounts to Link Cisco Unity Connection 8.5 and Later Users to Exchange
Mailboxes” section on page 2-43.

Delete the unified messaging account that accessed the Exchange server from which the mailbox was
moved:

a. In Cisco Unity Connection Administration, expand Users, then select Users.

b. On the Search Users page, select the alias of a user.

N

Note  If the user alias does not appear in the search results table, set the applicable parameters in the
search fields at the top of the page, and select Search.

c. On the Edit User Basics page, on the Edit menu, select Unified Messaging Accounts.

d. On the Unified Messaging Accounts page, check the check box to the left of the unified messaging
account that you want to delete.

e. Select Delete Selected.

Repeat Step 2 through Step 4 for the other Unity Connection users whose Exchange mailboxes you
moved.
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Restoring Microsoft Exchange Mailboxes in
Cisco Unity Connection 8.5 and Later When
Single Inbox is Enabled

This chapter contains the following sections:
¢ Why Disabling Single Inbox is Important Before Restoring Exchange Mailboxes, page 5-1

e Task List for Restoring Microsoft Exchange Mailboxes in Cisco Unity Connection 8.5 and Later
When Single Inbox is Enabled, page 5-2

e Disabling Single Inbox for Cisco Unity Connection 8.5 and Later, page 5-3

Why Disabling Single Inbox is Important Before Restoring
Exchange Mailboxes

A

If you want to restore Exchange mailboxes and the single-inbox unified messaging service capability is
enabled for Cisco Unity Connection users whose Exchange mailboxes are being restored, you must
disable single inbox for those users before you restore Exchange.

For information on how disabling single inbox affects synchronization behavior, see the “How Disabling
and Re-enabling Single Inbox Affects the Synchronization of Unity Connection and Exchange
Mailboxes” section on page 2-10.

Caution

If you do not disable single inbox for Unity Connection users whose Exchange mailboxes are being
restored, Unity Connection will not resynchronize voice messages that were received between the time
that the backup from which you are restoring was created and the time that the restore is complete.

Unity Connection maintains a synchronization cache that tracks which voice messages have already been
forwarded to Exchange. When you disable single inbox, the synchronization cache is automatically
cleared. Here is how it works:

1. You back up Exchange.
2. A new voice message arrives.

3. Unity Connection synchronizes the voice message with the Exchange mailbox associated with the
Unity Connection user.
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10.

1.

12.

Unity Connection updates the synchronization cache for that user to indicate that the message has
been synchronized with Exchange.

A hard disk in the Exchange server fails.

You disable single inbox for the Unity Connection user whose Exchange mailbox was on the failed
hard disk.

Unity Connection clears the synchronization cache for that user.
You replace the hard disk and restore Exchange from the backup that you made in 1.
You re-enable single inbox for the user.

Unity Connection performs a periodic comparison of the synchronization cache with the voice
messages currently in Exchange.

Because the cache is empty, Unity Connection concludes that voice messages that are in the Unity
Connection mailbox but not in the Exchange mailbox have not yet been synchronized with
Exchange.

Unity Connection resynchronizes the Unity Connection mailbox with the Exchange mailbox, and
rebuilds the synchronization cache.

If you restore Exchange mailboxes without disabling single inbox for the Unity Connection users, here
is an explanation of why Unity Connection deletes all voice messages that were received after the backup
from which you are restoring:

1.
2.
3.

You back up Exchange.
A new voice message arrives.

Unity Connection synchronizes the voice message with the Exchange mailbox associated with the
Unity Connection user.

Unity Connection updates the synchronization cache for that user to indicate that the message has
been synchronized with Exchange.

A hard disk in the Exchange server fails.
You replace the hard disk and restore Exchange from the backup that you made in 1.

Unity Connection performs a periodic comparison of the synchronization cache with the voice
messages currently in Exchange. The voice message that arrived in 2. is not in the Exchange mailbox
for the associated Unity Connection user.

Unity Connection concludes that the voice message has already been synchronized with Exchange
and does not resynchronize the message into the Exchange mailbox.

Task List for Restoring Microsoft Exchange Mailboxes in
Cisco Unity Connection 8.5 and Later When Single Inbox is

Enabled

Disable single inbox for selected users or for a unified messaging service. See the “Disabling Single
Inbox for Cisco Unity Connection 8.5 and Later” section on page 5-3.

Restore Exchange mailboxes. For more information, see the applicable Microsoft documentation.

Re-enable single inbox by reversing the procedure that you used to disable single inbox in Task 1.:
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Disabling Single Inbox for Cisco Unity Connection 8.5 and Later

— If you disabled single inbox for individual users by using Unity Connection Administration,
repeat the “To Disable Single Inbox for Individual Users for Unity Connection 8.5 and Later”
procedure on page 5-4, but check the Synchronize Unity Connection and Exchange
Mailboxes (Single Inbox) check box.

- If you disabled single inbox for a unified messaging service, repeat the “To Disable Single
Inbox for All of the Users Associated with a Unified Messaging Service” procedure on
page 5-4, but check either the Synchronize Connection and Exchange Mailboxes (Single
Inbox) check box or the Enabled check box, as applicable.

— If you disabled single inbox for individual users by using the Bulk Administration Tool, repeat
the “To Disable Single Inbox for a Large Numbers of Selected Users by Using the Bulk
Administration Tool for Unity Connection 8.5 and Later” procedure on page 5-5, but change the
value of enableMbxSynch to 1.

Disabling Single Inbox for Cisco Unity Connection 8.5 and Later

Note

The first step in restoring Exchange mailboxes is to disable single inbox, as noted in the “Why Disabling
Single Inbox is Important Before Restoring Exchange Mailboxes” section on page 5-1. You can do so in
several ways, depending on how many Exchange mailboxes you are restoring, whether you are restoring
Exchange mailboxes for all of the associated with a unified messaging service, and how concerned you
are about affecting Unity Connection functionality during the restore.

For information on how disabling single inbox affects synchronization, see the “How Disabling and
Re-enabling Single Inbox Affects the Synchronization of Unity Connection and Exchange Mailboxes”
section on page 2-10.

Restoring Exchange Mailboxes for a Small Number of Users

If you are restoring Exchange mailboxes for a small number of users, you can disable single inbox on
individual user accounts by using Unity Connection Administration. See the “To Disable Single Inbox
for Individual Users for Unity Connection 8.5 and Later” procedure on page 5-4.

Restoring Exchange Mailboxes for All of the Users Associated with a Unified Messaging Service, or Restoring
Mailboxes When Unity Connection Functionality Is Not a Concern

When you are restoring Exchange mailboxes and either of the following is true, you can disable single
inbox for a unified messaging service, which disables single inbox functionality for all users associated
with the unified messaging service:

* You are restoring mailboxes for all of the users associated with a unified messaging service.

* You are restoring mailboxes for selected users associated with a unified messaging service, and you
are restoring mailboxes during non-business hours, when interrupting single inbox functionality has
less impact on users.

There are two ways to disable single inbox for a unified messaging service:

e Disable only single inbox for a unified messaging service: If you disable only single inbox, the Unity
Connection conversation continues to play the options for the other unified messaging features. If a
user selects one of these features while Exchange is unavailable, the Unity Connection conversation
announces that access to messages is unavailable at this time.
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Step 1
Step 2

Step 3
Step 4
Step 5
Step 6
Step 7

Step 1
Step 2

Step 3

e Disable an entire unified messaging service: If the unified messaging service also has the other
unified messaging features enabled and you disable the service, the Unity Connection conversation
stops playing the options for those features until the unified messaging service is re-enabled, which
could be confusing for users.

See the “To Disable Single Inbox for All of the Users Associated with a Unified Messaging Service”
procedure on page 5-4.

Restoring Exchange Mailboxes for Some but Not All Users Associated with a Unified Messaging Service When
Unity Connection Functionality Is a Concern

When you are restoring Exchange mailboxes for a large number of users who are associated with a
unified messaging service and both of the following are true, you can use the Bulk Administration Tool
to disable single inbox for individual users:

¢ The unified messaging service also includes users whose mailboxes you are not restoring.

* You are restoring the mailboxes during business hours, when you want to minimize the impact on
users whose mailboxes you are not restoring.

See the “To Disable Single Inbox for a Large Numbers of Selected Users by Using the Bulk
Administration Tool for Unity Connection 8.5 and Later” procedure on page 5-5.

To Disable Single Inbox for Individual Users for Unity Connection 8.5 and Later

In Unity Connection Administration, select Users.
On the Search Users page, select the alias of the user account that you want to modify.

~

Note  If the user does not appear in the search results table, set the applicable parameters in the search
fields at the top of the page, and select Find.

On the Edit menu, select Unified Messaging Accounts.

Select the unified messaging account that enables single inbox for this user.

Uncheck the Synchronize Unity Connection and Exchange Mailboxes (Single Inbox) check box.
Select Save.

Repeat Step 1 through Step Step 6 for the remaining users.

To Disable Single Inbox for All of the Users Associated with a Unified Messaging Service

In Unity Connection Administration, select Unified Messaging > Unified Messaging Services.

On the Search Unified Messaging Services page, select the alias of the unified messaging service that
you want to modify.

A

Note  If the unified messaging service does not appear in the search results table, set the applicable
parameters in the search fields at the top of the page, and select Find.

To disable only single inbox for the users associated with this unified messaging service, uncheck the
Synchronize Connection and Exchange Mailboxes (Single Inbox) check box.
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Step 4
Step 5

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Step 9

Step 10
Step 11
Step 12
Step 13

Disabling Single Inbox for Cisco Unity Connection 8.5 and Later

To disable the entire unified messaging service, uncheck the Enabled check box.
Select Save.

Repeat Step 1 through Step 4 for other unified messaging services for which you want to disable single
inbox.

To Disable Single Inbox for a Large Numbers of Selected Users by Using the Bulk Administration Tool for Unity
Connection 8.5 and Later

In Unity Connection Administration, select Tools > Bulk Administration Tool.
Under Select Operation, select Export.

Under Select Object Type, select Unified Messaging Accounts.

Specify a filename for the CSV file to which unified messaging accounts are exported.
Select Submit.

Follow the onscreen prompts to save the CSV file.

Open the CSV file.

For the users for whom you want to disable the single-inbox feature, change the value of
enableMbxSynch to 0.

In Unity Connection Administration, select Tools > Bulk Administration Tool.
Under Select Operation, select Update.

Under Select Object Type, select Unified Messaging Accounts.

Specify the name of the CSV file that you updated in Step 8.

Select Submit.
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Configuring Cisco Unity Connection 8.5 and Later
and Cisco Unified MeetingPlace for Unified
Messaging

When integrated with Cisco Unified MeetingPlace 8.x, Cisco Unity Connection enables users to do the
following by phone:

e Join a meeting that is in progress.
e Hear a list of the participants for a meeting.
¢ Send a message to the meeting organizer.
e Send a message to the meeting participants.
e Set up immediate meetings.
¢ (Cancel a meeting (meeting organizers only).
See the following sections:
e Task List for Creating a Calendar Integration with Cisco Unified MeetingPlace, page 6-1
e Requirements for the Cisco Unified MeetingPlace Calendar Integration, page 6-2
¢ Configuring Cisco Unified MeetingPlace for the Calendar Integration, page 6-2
e Creating a Unified Messaging Service to Access Cisco Unified MeetingPlace, page 6-4

Creating Unified Messaging Accounts to Link Cisco Unity Connection 8.5 and Later Users to Cisco
Unified MeetingPlace Users, page 6-5

Testing the Calendar Integration for the Cisco Unified MeetingPlace Calendar Integration, page 6-6

Task List for Creating a Calendar Integration with Cisco Unified
MeetingPlace

Use the following task list to create a calendar integration with Cisco Unified MeetingPlace:

1. Review the system requirements to confirm that all requirements for Cisco Unified MeetingPlace
and the Cisco Unity Connection server have been met. See the “Requirements for the Cisco Unified
MeetingPlace Calendar Integration” section on page 6-2.

2. Configure Cisco Unified MeetingPlace. See the “Configuring Cisco Unified MeetingPlace for the
Calendar Integration” section on page 6-2.
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3. Configure Connection. See the “Creating a Unified Messaging Service to Access Cisco Unified
MeetingPlace” section on page 6-4.

4. If you configured Cisco Unified MeetingPlace to use HTTPS in Task 2., and configured unified
messaging services to validate certificates for MeetingPlace servers in Task 3.: on the Connection
server, in Cisco Unified Communications Operating System, upload certificates from the
certification authority that issued the SSL certificates for MeetingPlace servers to both tomcat-trust
and Connection-trust locations.

For SSL instructions, see the “Using SSL to Secure Client/Server Connections in Cisco Unity
Connection 8.x” chapter of the Security Guide for Cisco Unity Connection Release 8.x, available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/security/guide/8xcucsecx.html.

5. Configure the Connection users. See the “Creating Unified Messaging Accounts to Link
Cisco Unity Connection 8.5 and Later Users to Cisco Unified MeetingPlace Users” section on
page 6-5.

6. Test the calendar integration. See the “Testing the Calendar Integration for the Cisco Unified
MeetingPlace Calendar Integration” section on page 6-6.

7. To teach users how to list, join, and schedule meetings, see the “Managing Meetings” chapter of the
User Guide for the Cisco Unity Connection Phone Interface (Release 8.x) at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/user/guide/phone/b_8xcucugpho
ne.html.

Requirements for the Cisco Unified MeetingPlace Calendar
Integration

The calendar integration with Cisco Unified MeetingPlace has the following requirements:

¢ Cisco Unified MeetingPlace 8.x as described in the “Requirements for Accessing Calendar
Information for Meetings” section of System Requirements for Cisco Unity Connection Release 8.x
at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucsysreqs.html

e Cisco Unity Connection installed as described in the Installation Guide for Cisco Unity Connection
Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/installation/guide/8xcucigx.html

Configuring Cisco Unified MeetingPlace for the Calendar
Integration

Do the following procedures:
e To Configure Cisco Unified MeetingPlace for the Calendar Integration, page 6-3
e To Test the Cisco Unified MeetingPlace Configuration for the Calendar Integration, page 6-3
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Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

Step 1

Step 2
Step 3

Configuring Cisco Unified MeetingPlace for the Calendar Integration 1l

To Configure Cisco Unified MeetingPlace for the Calendar Integration

Sign in to the Cisco Unified MeetingPlace Application Server as an administrator.
Select User Configuration > User Profiles.
Select Add New.

Enter the following values in the required fields to create a privileged service account:

First Name Leave this field blank.

Last Name Enter Cisco Unity Connection.

User ID Enter cucsve or another user ID that you want.
User Password Enter the applicable password.

Profile Number Enter the applicable profile number.

Profile Password |Enter the applicable profile password.

Type of User Select System Administrator.

N

m The values that you enter for the User ID, User Password, Profile Number, and Profile Password
fields will be used in the “Creating a Unified Messaging Service to Access Cisco Unified
MeetingPlace” section on page 6-4.

Select Save.
Sign out of Cisco Unified MeetingPlace.

A

Caution  If you do not sign out of Cisco Unified MeetingPlace, the test will fail in the “To Test the Cisco
Unified MeetingPlace Configuration for the Calendar Integration” procedure on page 6-3.

To Test the Cisco Unified MeetingPlace Configuration for the Calendar Integration

In the Address field of a web browser, if SSL is not enabled, enter the following URL (where <server>
is the IP address or host name of the Cisco Unified MeetingPlace server):

http://<server>/webservices/services/meetingservice?wsdl
If SSL is enabled, enter the following URL.:

https://<server>/webservices/services/meetingservice?wsdl
Press Enter.

When prompted to sign in, enter the user ID and password for the privileged service account that you
created in the “To Configure Cisco Unified MeetingPlace for the Calendar Integration” procedure on
page 6-3.

The Cisco Unified MeetingPlace WSDL download page appears with the title “XFire Services.”
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M Creating a Unified Messaging Service to Access Cisco Unified MeetingPlace

Creating a Unified Messaging Service to Access Cisco Unified
MeetingPlace

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6
Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Do the following procedure.

To Create a Unified Messaging Service to Access Cisco Unified MeetingPlace

In Cisco Unity Connection Administration, select Unified Messaging > Unified Messaging Services.
On the Search Unified Messaging Services page, select Add New.

On the New Unified Messaging Service page, in the Type list, select MeetingPlace 8.x.

Check the Enabled check box to enable the service.

When this check box is not checked, the integration with Cisco Unified MeetingPlace is disabled.

In the Display Name field, enter a descriptive name.

In the Server field, enter the IP address or host name for the Cisco Unified MeetingPlace server.

In the Transfer Extension Dial String field, enter the digits that Connection must dial to transfer users
on the phone to the opening greeting of Cisco Unified MeetingPlace server.

In the Web-Based Protocol field, select HTTPS or HTTP, as applicable.

If you selected HTTPS and you want Connection to validate the Cisco Unified MeetingPlace server
certificate, check the Validate Certificates for MeetingPlace Servers check box.

A

Caution The CN value on the server certificate subject line or the subjectAltName:dnsname field of
the server certificate must match the setting of Server field. Otherwise, validation of the server
certificate will fail.

The root certificate or all certificates in a root certificate chain of the Certification Authority
(CA) that signed the server certificate must be installed as Connection-trust certificates in
Cisco Unified Operating System Administration. Otherwise, validation of the server
certificate will fail.

In the User ID field, enter the user ID for the privileged service account that Connection uses to sign in
to the Cisco Unified MeetingPlace server.

This setting must match the User ID setting for the privileged service account that you configured in the
“Configuring Cisco Unified MeetingPlace for the Calendar Integration” section on page 6-2.

In the Password field, enter the password for the privileged service account that Connection uses to sign
in to the Cisco Unified MeetingPlace server.

This setting must match the User Password setting for the privileged service account that you configured
in the “Configuring Cisco Unified MeetingPlace for the Calendar Integration” section on page 6-2.

Under Service Capabilities, check the applicable check boxes:

e Announce MeetingPlace Meetings—Check this check box so that users can hear of their upcoming
meetings by phone.

e MeetingPlace Scheduling and Joining—Check this check box so that users can schedule and join
meetings.

Select Save.
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Creating Unified Messaging Accounts to Link Cisco Unity Connection 8.5 and Later Users to Cisco Unified

Step13  To check the integration with Cisco Unified MeetingPlace, select Test. The Task Execution Results
window appears with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace and Cisco Unity
Connection.

Creating Unified Messaging Accounts to Link Cisco Unity
Connection 8.5 and Later Users to Cisco Unified MeetingPlace
Users

Do the following procedure.

A

Caution  Cisco Unified MeetingPlace must have an end user for each Connection user that you are configuring.

To Create Unified Messaging Accounts to Link Cisco Unity Connection 8.5 and Later Users to Cisco Unified
MeetingPlace Users

Step 1 In Cisco Unity Connection Administration, expand Users, then select Users.
Step2  On the Search Users page, select the alias of a user.
Step3  On the Edit User Basics page, on the Edit menu, select Unified Messaging Accounts.

Step4  On the Unified Messaging Accounts page, select Add New. The New Unified Messaging Account page
appears.

Step5 In the Unified Messaging Service field, select the display name that you entered in the “Creating a
Unified Messaging Service to Access Cisco Unified MeetingPlace” section on page 6-4.

Step6  In the Sign-In Type field, select the applicable option:

e Use Connection Alias—This option is useful when the Cisco Unified MeetingPlace profile alias is
the same as the Connection user alias. Connection signs in the user with the Connection user alias.
Cisco Unified MeetingPlace provides information on public and private meetings to the user.

¢ Use Server Guest Account—Connection signs in the user as a guest, without using the Connection
user alias or the User ID setting. Cisco Unified MeetingPlace provides information only on public
meetings to the user.

e Use User ID Provided Below—Enter the profile alias from Cisco Unified MeetingPlace (useful
when the Cisco Unified MeetingPlace profile alias is different from the Connection user alias).
Connection signs in the user with the setting in this field. Cisco Unified MeetingPlace provides
information on public and private meetings to the user.

Step7  (Only when the Use User ID Provided Below option is selected in Step 6) In the User ID field, enter the
User ID setting from Cisco Unified MeetingPlace.

Step8  Under Service Capabilities, check the applicable check boxes:

¢ MeetingPlace Scheduling and Joining—Check this check box so that the user can schedule and
join meetings.
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I Testing the Calendar Integration for the Cisco Unified MeetingPlace Calendar Integration

Step 9
Step 10

Step 11

¢ Primary Meeting Service—If the MeetingPlace Scheduling and Joining check box is checked for
two or more unified messaging services, check this check box so that Cisco Unified MeetingPlace
meetings will be set up through this Cisco Unified MeetingPlace server. Uncheck this check box so
that Cisco Unified MeetingPlace meetings will be set up through another server.

Select Save.

To check the calendar configuration for the user, select Test. The Task Execution Results window
appears with the test results.

If any part of the test fails, verify the configuration for Cisco Unified MeetingPlace, Cisco Unity
Connection, and the user.

Repeat Step 2 through Step 10 for all remaining users.

Testing the Calendar Integration for the Cisco Unified
MeetingPlace Calendar Integration

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Do the following procedure.

To Test the Configuration for the Cisco Unified MeetingPlace Calendar Integration

Sign in to Cisco Unified MeetingPlace as an end user.
Select Schedule.

Enter values in the required fields to schedule a new meeting for the current time, and invite a user who
has an account on Cisco Unity Connection.

Sign in to the Connection mailbox of the user that you invited to the Cisco Unified MeetingPlace meeting
in Step 3.

If the user account is configured for voice recognition, say Play Meetings.

If the user account is not configured for voice recognition, press 6, and then follow the prompts to list
meetings.

When you hear the system announce the Cisco Unified MeetingPlace meeting that you just scheduled,
either say Join, or press the applicable keys on the phone keypad to join the meeting.
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